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Κεφάλαιο   1   ΚΚεεφφάάλλααιιο 1ο 1
 

1.1 ΠΡΟΛΟΓΟΣ 
 
 
Σκοπός της εργασίας, είναι η οπτικοακουστική εξοικείωση των 

γραμμάτων «θ, φ, δ, β», για μαθητές με μαθησιακές δυσκολίες, σ’ 
ένα ευχάριστο περιβάλλον, εξασκώντας την παρατηρητικότητά 

Η επίδοση του μαθητή εξαρτάται σε μεγάλο βαθμό από: 
- το νοητικό του επίπεδο 

ισθητηριακές αναπηρίες 
- από την εμφάνιση συγκεκριμένων μαθησιακών δυσκολιών: 

o δυσλεξία  
o διάσπαση προσοχής  
o ελάχιστη εγκεφαλική δυσλειτουργία 

Ο μαθητής, έχει μια εικόνα των γραμμάτων που ακούει, καθώς 
κούει και το γράμμα πώς προφέρεται και μια λέξη που ξεκινάει 
πό το αντίστοιχο γράμμα. 

 Η εργασία έχει πραγματοποιηθεί, xρησιμοποιώντας το 
 της Macromedia το DirectorMX2004. 

 
 
 
 
 
 
 
 
 
 
 

 
 

 

τους και το λεξιλόγιό τους. 
 

- από τυχόν α

 

α
α

πρόγραμμα
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1.2 ΠΕΡΙΓΡΑΦΗ ΠΤΥΧΙΑΚΗΣ ΑΣΚΗΣΗΣ 

Απαιτήσεις – Κανόνες Άσκησης 

μφανίζεται κατά το 30% του συνόλου 
o στην πρώτη καρτέλα το «θ» να έχει διαφορετικό χρώμα 

 διαφορετική 

crable 

αδή αν το γράμμα που πάτησε είναι π.χ. το 
ια σ ι

, π.χ. « θ , όπως 
θάλασσα» και θα επιβραβεύεται ακούγοντας το «Μπράβο, το 
βρήκες» 

o αν είναι λάθος, π.χ. αν πατήσει το «κ», τότε θ’ ακούγεται «κ , 
όπως κότα, προσπάθησε ξανά» 

 
 
 
 
 
 
 

 

 
1.2.1 Α’ Άσκηση 
 

 
1. ποσότητα 

o 150 γράμματα σε 3 καρτέλες 
o το γράμμα «θ» να ε

o στις 3 καρτέλες τα φωνήεντα και τα σύμφωνα να έχουν 
διαφορετικό χρώμα 

o σε κάθε καρτέλα το γράμμα να είναι
συμβολοσειρά, έτσι ώστε ο μαθητής να έχει μια γενικευμένη 
εικόνα του γράμματος 

 
2. αισθητική 

o κάθε γράμμα να μοιάζει σαν πλακάκι του s
 

3. πράξη 
όταν ο μαθητής θα πατά ένα γράμμα: 
 
o αν είναι σωστό, δηλ

«θ» (γ  την ά κηση του γράμματος «θ»), τότε θα ακούγετα  το 
γράμμα και μια λέξη που θ’ αρχίζει από αυτό
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Αρχική φόρμα της άσκησης 
 
 

 
       Γράφοντας το
 

 όνομα και το επώνυμο, ο μαθητής  διαλέγει γράμμα. 

 
ΓΡΑΜΜΑ «Θ» 

 
 

 
καθώς
προχωράμε
από υ 
θέλουμε

 α 
ποία οιχο γράμμα, τα οποία είναι 15 
ε κάθε καρτέλα. Υπάρχει ένας μετρητής γραμμάτων και όταν βρεθούν και 
τα 15 γράμματα προχωράμε στην επόμενη καρτέλα. 

 

Ξεκινώντας την εργασία, ηχογραφήθηκαν οι λέξεις, οι οποίες ακούγονται
 ο μαθητής πατά ένα γράμμα. Φτιάχνοντας το περιβάλλον εργασίας 

 στον κώδικα. Έχουμε μια συνάρτηση, την οποία καλούμε πίσω 
κάθε γράμμα περνώντας την αντίστοιχη ηχογραφημένη λέξη πο

 στο αντίστοιχο γράμμα. 
 

Για κάθε γράμμα ακολουθούν τρεις καρτέλες με 50 γράμματα, από τ
 ο μαθητής, θα πρέπει να βρει το αντίστο

σ
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Α’ Καρτέλα για το γράμμα «θ» 
 
 

θ ε π κ λ θ χ θ δ α 
 

α θ λ χ δ ε θ κ π θ 
 

θ κ α θ π χ λ θ ε δ 
 

ε θ π δ θ κ θ χ α λ 
 

λ κ χ θ ε π α θ δ θ 

 
Λέξεις που χρησιμοποιούνται:

 
 

 
 

o θάλαμος, εκδρομή, πέλαγος, καρπός, λιβάδι, θαύμα, χελιδόνι, 
θέαμα, δάσος, άρωμα 

o αστραπή, θεόρατος, λιμάνι, χαρά, δάχτυλο, ελέφαντας, Θεός, 
πελώριος, καρύδι, θεραπεία  

o θερινός, κήπος, αγώνας, θερμός, πηγή, χορός, λυγερός, 
θαυμάζω, επίθεση, διαβάζω 

o ευχή, θαυμαστικό, πιρούνι, δέντρο, θέση, κλωνάρι, θεωρία, 
χήνα, άνεμος, λελέκι 

o λιοντάρι, κορμί, χειμώνας, θολός, ελάφι, παπαγάλος, αετός, 
θρησκεία, δεξί, θύελλα 
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 Β’ Καρτέλα για το γράμμα «θ» 
 

 
 

 
 

 
 

 
 

 
 
 
Λέξεις που χρησιμοποιούνται :

 
α θ φ γ θ β ψ ο θ τ 

θ β θ τ ο φ θ γ ψ α 

ο τ ψ θ α γ θ β φ θ 

θ α β φ θ ψ γ θ ο τ 

ο θ τ γ β θ α ψ φ θ 

 

 ακούω , θάβω, φακή, γαλάζιο, θάμνος, βάφω, ψαλίδι, 

Θανάσης, τρέμω, όνειρο, φάλαινα, 

αρραλέος, φεγγάρι, αλεπού, θήκη, 

λίο, ψωμί, θρανίο, γυρίζω, φέτα, 

, τυρί, γάλα, θώρακας, βρίσκω, ανοίγω, 

 

 
o

ομπρέλα, θαλασσί, τραπέζι 
o θαμπός, βάζω, 

θαλασσινός, γάτα, ψαράς, άκρη 
o όρεξη, ταξίδι, ψάχνω, θ

βεράντα, γελάω, θόρυβος 
o θάλασσα, αλλάζω, βιβ

θράσος, όμορφος, τηγάνι 
o όροφος, θρόνος

ψέμα, φωτιά, θηλυκό 
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 Γ’ Καρτέλα για το γράμμα «θ» 
 
 

ε θ ξ μ θ η θ ρ ν σ  
 
θ η θ ρ σ ν μ θ ε ξ  
 
ξ θ ε σ θ ρ η ν μ θ  
 
ν η θ ξ μ σ θ ρ ε θ  
 
μ θ ρ ε σ θ η θ ξ ν  
 
 
Λέξεις που χρησιμοποιούνται : 
 

o ελιά, θυμάμαι, ξανθός, μυρμήγκι, θυμάρι, ήρωας, θυμίζω, 
ραντίζω, ναύτης, σέρνω 

o θυμώνω, ηφαίστειο, θυσιάζω, ρόλος, σακούλα, ντουλάπι, 
μαγκάλι, θέμα, ενώνω, ξινό 

o ξένος, θησαυρός, έπαθλο, στάχτη, θηρίο, ρωγμή, ήλιος, 
νεράιδα, μουσείο, θυμός 

o νεροχύτης, Ήρα, Θωμάς, ξύλο, μαραγκός, σκύλος, θείος, 
ραπανάκι, ερευνώ, θάρρος 

μος
o μολύβι, θέλω, ρεύμα, έθνος, σόμπα, θεία, ηλιαχτίδα, 

θαλαμηγός, ξυράφι, νό  
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1.2.2 Β’ Άσκηση 
 
 
 Υπάρχει  σύνολο έν  γι  γ μμα  
σύνολ ια τ ράμ τα β,   
 Θέλουμε από τις εικόνες να διαλέγει ο μαθητής μια εικόνα και να την 
αντιστοιχεί  σωστό ολο ια γράμματα , θ  
σκέφτεται ποια εικόνα έχει ή αρχίζει από τα αντίστοιχα γράμματα των 
συνόλων που  αν . 
 

ένα εικόνων, α σύνολο α το ρά  «θ» κι ένα
ο γ α γ μα «φ, δ».

στο σύν  γ τα . Δηλαδή α πρέπει να

 θα τιστοιχεί

 
 

 

γράμματα γράμματα τις αλφαβήτου. 

αν φίες στο σωστό πλαίσιο. 

 

Υπάρχουν τρεις φάκελοι οι οποίοι περιέχουν τις φωτογραφίες με τα 
 «θ», «φ δ β» και με τα υπόλοιπα 

Με τυχαία σειρά φορτώνονται στην άσκηση και ο μαθητής πρέπει να 
τιστοιχήσει τις σωστές φωτογρα
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ΚΚΚεεεφφφάάάλλλαααιιιοοο   222   
 
ΠΠΠΡΡΡΟΟΟΓΓΓΡΡΡΑΑΑΜΜΜΜΜΜΑΑΑ   ΥΥΥΛΛΛΟΟΟΠΠΠΟΟΟΙΙΙΗΗΗΣΣΣΗΗΗΣΣΣ   ΚΚΚΑΑΑΙΙΙ   ΛΛΛΕΕΕΙΙΙΤΤΤΟΟΟΥΥΥΡΡΡΓΓΓΙΙΙΑΑΑΣΣΣ   

 2004 
 
2.1 Macromedia Director MX
 
 
 

 
 
2.2 Σχετικά με το Director 

 
      Το πρόγραμμα Director της εταιρείας Macromedia, είναι ένα 
αποδεδειγμένο εργαλείο δημιουργίας πολυμέσων για τους επαγγελματίες, 
μπορούμε να αναπτύξουμε υψηλής απόδοσης περιεχόμενο και να το 
επεκτείνουμε οπουδήποτε: σε CDs, DVDs, intranets, ή το διαδίκτυο.  

Είτε δημιουργήσουμε το ενισχυμένο ικανοποιημένο, εκπαιδευτικό 
περιεχόμενο CD/dvd-*ROM, ή οι εφαρμογές ψυχαγωγίας, το rector 
ειρίζεται την ευρύτερη ποικιλία των μέσων, αφήνοντάς μας να 
εξαπολύσουμε

τη
πιλογής, προγραμματίζοντας γλώσσες και cross-platform publishing. 

  

 Di
χ

 την δημιουργικότητα και χτίζει την πλούσια, διαλογική 
εμπειρία που παραδίδει τα μετρήσιμα αποτελέσματα.  

Το πρόγραμμα Director, παρέχει όλα τα εργαλεία που πρέπει να 
μεγιστοποιήσουμε ν παραγωγικότητα, συμπεριλαμβανομένης μιας 
ε

 13



Με ορούμε να κάνουμε όλα τα ακόλουθα:  το Director, μπ  
 

μέσων στα 
ρογράμματα πολυμέσων μας, που περιλαμβάνονται σε DVD-Video, 

 περιεχόμενα σε Macromedia 
κόνας (bitmap) και τρισδιάστατα 

χήματα (3D).  
Επεκτείνουμε το περιβάλλον που σχεδιάζουμε και την μηχανή 

ναπαραγωγής ήχου με τη σύνδεση επέκτασης, Xtra αρχιτεκτονική στο 
Director. Χρησιμοποιούμε τις επεκτάσεις Xtra τρίτων ή γράφουμε δικούς 
μας ελέγχους για τις εξωτερικές συσκευές, όπως joysticks και φωτογραφικές 
μηχανές και εκτελούν περίπλοκα καθήκοντα λειτουργικού - συστήματος.  
• Γράφουμε χειρόγραφα για να προσθέσουμε την αλληλεπίδραση και την 
αυτοματοποίηση στα προγράμματά μας, χρησιμοποιώντας Lingo γλώσσα, 
σύνταξη JavaScript, ή ένα συνδυασμό των δύο.  

Οι χρήστες βλέπουν τις ολοκληρωμένες ταινίες Director  μ’ έναν από 
ους ακόλουθους τρόπους:  

 παίζει στον υπολογιστή του χρήστη ως 

• Σε

• Ενσωματώνουμε τα περισσότερα σημαντικά σχήματα 
π
Windows Media, RealMedia, QuickTime, και

lash, σε αντίθεση ήχου, δυαδικό αρχείο ειF
σ
• 
α

μας
τ
• Σε έναν προβολέα, ο οποίος
αυτόνομη εφαρμογή.  

 εκτέλεση του Macromedia Shockwave Player, το οποίο παίζει με 
browsers Shockwave-διαθέσιμοι στον Ιστό. Τα εκατομμύρια των χρηστών 
Ιστού έχουν ήδη το Shockwave Player στους υπολογιστές τους, browsers, ή 
λογισμικό συστημάτων. 
 

 
               Το παράθυρο των Cast, Stage, Score στο Director. 

 
 Η δράση σε μια ταινία Director παίρνει μέρος σ’ ένα παράθυρο που 
ονομάζεται Stage. Για να δημιουργήσουμε μια ταινία Director, 
προσθέτουμε στοιχεία πολυμέσων, που ονομάζονται cast members, στο 
παράθυρο Cast, δημιουργώντας αυτά με το Director ή τα εισάγουμε. 
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Έπειτα, τοποθετούμε αυτά στο Stage ως sprites. Ένα sprite είναι μια απλή 
αντιγραφή ενός cast member το οποίο εμφανίζεται στο Stage.  

 σ τ ά ζ   default 

 
 
2.3 Γνωρίζοντας το default Director workspace 
 
      Όταν δημιουργούμε και επεξεργαζόμαστε μια βασική ταινία, είναι σαν 
να δουλεύουμε ε έσσερα παρ θυρα που εμφανί εται στο
workspace : το Stage, το Score, το Cast window και το Property inspector. 
Από το παράθυρο Cast μπορούμε να εισάγουμε, να δημιουργήσουμε και να 
επεξεργαστούμε τα cast members της ταινίας μας. Στο Property inspector, 
μπορούμε να ελέγχουμε τις ιδιότητες αυτών. Με το Stage και το Score 
μπορούμε να ελέγχουμε πώς, πού, πότε και για πόσο τα στοιχεία πολυμέσων 
εμφανίζονται στην ταινία μας.  
 

 
                           The default Director workspace (Windows platform) 
 
 
2.3.1 Διαχειρίζοντας το default Director workspace 
 
        Το default workspace είναι σχεδιασμένο για πολλούς ανθρώπους οι 
οποίοι είναι νέοι στο να χειρίζονται το Director, αλλά μπορούμε να 
χειριστούμε το workspace να εξυπηρετεί τις δικές μας ανάγκες. Μπορούμε 
να προσθέτουμε παράθυρα όσο τα χρειαζόμαστε και να τα κρύβουμε έτσι 
ώστε ν ησιμοποιούμε.  α κρατάμε το workspace καθαρό και εύκολο να το χρ
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Μπορούμε επίσης, να ελέγχουμε πώς τα παράθυρα θα εμφανίζουν τα 
περιεχόμενά τους αλλάζοντας τις ιδιότητες των παραθύρων.  
Για να  ή να κρύψουμε ένα παράθυρο :  

από τη λίστα του 

ρων στο Director : παράθυρα εγγράφου και 
αράθυρα εργαλείων. Τυπικά χρησιμοποιούμε παράθυρα εγγράφου για να 
δημιουργούμε ή να επεξεργαζόμαστε περιεχόμενο, χρησιμοποιούμε 
παράθυρα εργαλείων να εμφανίσουμε ή διαχειριστούμε τις ιδιότητες αυτών 
των περιεχομένων. 

Για παράδειγμα, το παράθυρο Paint είναι ένα παράθυρο εγγράφου. Αυτό 
επιτρέπει να δημιουργούμε και να επεξεργαζόμαστε εικόνες. Σε αντίθεση, 
το Property inspector είναι ένα παράθυρο εργαλείων και επιτρέπει ν’ 
αλλάξουμε τις ιδιότητες μιας εικόνας την οποία δημιουργήσαμε με το 
παράθυρο Paint. Και οι δύο τύποι παραθύρων είναι διαθέσιμα από το μενού 
Window. 

 
νται στα ακόλουθα : 

 εμφανίσουμε
1. ανοίγουμε το μενού Window  
2. διαλέγουμε ένα από τα ονόματα των παραθύρων 

μενού.  
Για να αλλάξουμε τις ιδιότητες παραθύρων :  

1. διαλέγουμε Edit > Preferences  
2. διαλέγουμε ένα από τα ακόλουθα : General, Score, Sprite, Cast, 

Paint, Editors, ή Script. 
 
2.3.2 Γνωρίζοντας τους τύπους παραθύρων 
 

Υπάρχουν δύο τύποι παραθύ
π

Μερικά παραδείγματα παραθύρων εγγράφου περιέχο  
Stage • Score • Cast • Various media editors (π.χ. Text, QuickTime και 

ακόλουθα:

• 
DVD)  
ερικά παραδείγματα παραθύρων εργαλείων περιέχονται στα Μ  

 • Property inspector • Tool palette • Text inspector • Control panel 
 
2.3.3 Stage 
 

Το Stage είναι το κομμάτι της ταινίας που οι χρήστες θα δουν. 
Χρησιμοποιούμε το Stage να αποφασίσουμε πού τα στοιχεία πολυμέσων 
(cast members) θα εμφανίζονται στην οθόνη, έπειτα τοποθετούμε ένα 
αντίγραφο του cast member, το οποίο ονομάζεται sprite, στο Stage.  

Κατά την διάρκεια της σχεδίασης μπορούμε να αλλάξουμε τις ιδιότητες 
του Stage, ως προς το χρώμα ή και το μέγεθός του. Τα παράθυρα των 
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οδηγών (Guides), grids, Align and Tweak είναι διαθέσιμα να σχεδιάσουμε 
τα sprites στο Stage. 

 
Για να κινηθούμε στο Stage : 
Εάν το Stage δεν είναι ήδη εμφανίσιμο, διαλέγουμε Window > Stage 

1. κάνουμε ένα από τα παρακάτω : 

έγουμε το εργαλείο Hand     από την παλέτα Tool, διαλ
 πατάμε και κρατάμε την spacebar  

2. τοποθετούμε το hand tool στο Stage, κλικ και τραβάμε να                                               
     μετακινήσουμε το Stage 

2.3

 

.4 Το εργαλείο Zoom   
 
Για να μεγεθύν υμ  (zoom in) το Stage : 

1. από την παλέτα Tool, διαλέγουμε το εργαλείο Magnifying Glass 
2. κάνουμε κλικ

ο ε

 στο stage μέχρι να γίνει το επιθυμητό μέγεθος 
 

2.3.5  περιοχή offstage canvas 

ω από την ενεργή περιοχή της ταινίας. Αυτή η περιοχή είναι 

Για να σμικρύνουμε (zoom out) το stage : 
1. από την παλέτα Tool, διαλέγουμε το εργαλείο Magnifying Glass 
2. πατάμε και κρατάμε το πλήκτρο Alt και ύστερα κλικ στο stage μέχρι 

να γίνει το επιθυμητό μέγεθος 
 

Η
 

Το Stage περιέχει μια offstage canvas περιοχή με το παράθυρο stage 
αλλά, έξ
χρήσιμη για να τοποθετούμε τα sprites είτε πριν είτε μετά την εμφάνισή 
τους στο stage.  
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2.4 Score 
 

Όπως το Stage, το Score αποτελεί μια όψη της ταινίας. Το Stage, 
 το Score μια όψη του χρόνου της ταινίας. Το 

με το 

Το Score οργανώνει και ελέγχει τα περιεχόμενα της ταινίας με τον χρόνο 
σε  
spr Τα sprites channels είναι 

Ακ επιδρούν στο tempo της ταινίας, στον ήχο, 
παλέτες χρωμάτων, transitions και scripted behaviors. 

αποτελεί μια γραφικά όψη, ενώ
Stage εμφανίζεται στο σημείο του χρόνου το οποίο εμπεριέχεται 
Score.  

γραμμές που ονομάζονται κανάλια (channels). Επίσης, περιέχει πολλά
ites channels για τα sprites της ταινίας. 

αριθμημένα και ελέγχουν πότε τα sprites θα εμφανιστούν στην ταινία. 
όμη, περιέχει κανάλια που 

 
 

Εφόσον οι γραμμές του Score περιέχουν κανάλια, οι στήλες του Score 
εριέχουν frames. Ένα frame στηνπ  ταινία εκπροσωπεύει ένα μοναδικό 

οιο στην θεωρία μ’ ένα frame σ’ ένα 
ίναι σε λίστα μεταξύ των στηλών στο 

co
 δια 
εσα 

ίσης, να κάνουμε κλικ σε οποιοδήποτε frame στο score να 
ετακινήσουμε την γραμμή playhead σε αυτό το frame και να τραβήξουμε 
την γραμμή playhead πίσω ή μπροστά ανάμεσα στα frames. 
 

Δημιουργώντας έναν καινούργιο marker 
 

1. εάν το score δεν είναι ήδη εμφανίσιμο, διαλέγουμε  
     Window > Score 

σημείο στο χρόνο, το οποίο είναι παρόμ
elluloid film. Ο αριθμός των frames εc

s re.  
Μια κόκκινη κάθετη γραμμή, που ονομάζεται playhead, μετακινείται

μέσου των frames στο score δείχνοντας ποιο σημείο στο χρόνο είναι άμ
εμφανιζόμενο στο stage.  

Μπορούμε επ
μ
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2.  διαλέγουμε το frame το οποίο θέλουμε να μαρκάρουμε μ’ έναν 
marker 

3. κάνουμε κλικ στην άσπρη μπάρα στο κανάλι marker 
4.  διαλέγουμε το κείμενο του new marker και γράφουμε ένα όνομα που 

θέλουμε να δώσουμε στον νέο marker. 
 

 
 

Για να μετακινηθούμε σ’ έναν marker στο Score 
 
1. στο κανάλι marker, ανοίγουμε το μενού των markers 

 

 
2. διαλέγουμε το όνομα του marker που θέλουμε να μεταβούμε 

 

ξιά μεριά του Score. 
 

Για να κρύψουμε κάποιο από τα κανάλια πατάμε το κουμπί Hide/Show 
Effects Channels, πάνω δε
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2.5 Control Panel 
 

 
  
 

Για να εμφανίσουμε ή να κρύψουμε το Control Panel : 
• διαλέγουμε Window > Control Panel 

Για να εμφανίσουμε ή να κρύψουμε το Control toolbar : 
o διαλέγουμε View > Control Toolbar 

 
Καθώς χτίζουμε την ταινία, ίσως να θέλουμε να ελέγξουμε την πρόοδό 

μας περιοδικά παρακολουθώντας την ταινία στο Stage. Μπορούμε να 
ρησιμοποιήσουμε το Control Panel γι’ αυτήν την περίπτωση. 
Για ν’ αρχί στην αρχή 
(rewind) μια ταινία : 

ουμε  
       Window > Control Panel 
2. στο Control Panel, κάνουμε κλικ στο Rewind, στο Stop ή στο Play  
        κουμπί. Αυτά τα τρία κουμπιά εμφανίζονται στη αριστερή μεριά  
        του Control Panel 

Για να αλλάξουμε την ένταση του ήχου που παίζεται : 
o στο Control Panel, κάνουμε κλικ στο κουμπί Volume και 

ύστερα διαλέγουμε ένα επίπεδο της έντασης από το μενού 
 

 νέα cast members, 
α εμφανίσουμε ήδη υπάρχοντα cast members και να ελέγχουμε τις 
ιδιότητες για το κάθε ένα από αυτά. Δουλεύοντας στο Director, μπορούμε 
να χρησιμοποιήσουμε δύο ειδών cast members :  

o μπορεί να είναι στοιχεία πολυμέσων από την ταινία μας ως ήχο, 
κείμενο, γραφικά, κίνηση και βίντεο (τοποθετούνται στο stage 
ως sprites) 

o μερικά cast members μπορούν να εμφανίζονται στο Score αλλά 
όχι στο Stage, περιέχουν κώδικα (script), palettes, fonts, τα 
οποία μπορούμε να χρησιμοποιήσουμε στα κανάλια στο Score  

 

χ
σουμε (play), να σταματήσουμε (stop) , ή πίσω 

1. εάν το Control Panel δεν είναι ήδη εμφανίσιμο, διαλέγ

2.6 Cast 
 

Το παράθυρο Cast, περιέχει τα cast members της ταινίας μας. Το 
χρησιμοποιούμε για να δημιουργήσουμε ή να εισάγουμε
ν
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Στο παράθυρο Cast, μπορούμε να δημιουργήσουμε ή να εισάγουμε νέα 
ast members τα οποία εμφανίζονται ως Sprites στο Stage. Διαφορετικά 

sprites μπορούν να δημιουργηθούν από ένα μόνο cast member. Κάθε sprite 
μπορεί να έχει τις δικές του τιμές για διαφορετικές ιδιότητες και οι 
περισσότερες αλλαγές αυτών ιδιοτήτων δεν επηρεάζουν τα cast members. 
ι περισσότερες αλλαγές σ’ ένα cast member, εν τούτοις, θ’ αλλάξει τα 

c

Ο
sprites που δημιουργήθηκαν από αυτό το cast member. 
 
 

 

τττο   παράθυρο   cast   συμπληρωμένο   με   cast   members   μοοππααρράάθθυυρροο ccaassttσσυυμμππλληηρρωωμμέέννοο μεε ccaasstt mmeemmbbeerrss
 
 

υργήσουμε ένα νέο cast member 

 παλέτα Tool, διαλέγουμε ένα κουμπί κειμένου, ζωγραφικής ή  
               ελέγχου 

 

Για να δημιο
 

1. εάν το παράθυρο Cast δεν είναι ήδη εμφανίσιμο, διαλέγουμε  
Window > Cast 

 
2. στην

 
3. πατάμε κλικ στο Stage να τοποθετήσουμε το νέο cast member, τώρα 

cast member εμφανίζεται στο παράθυρο Cast 
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Για να εισάγουμε ένα cast member από ήδη υπάρχον αρχείο πολυμέσων 
 
 

1. εάν το παράθυρο Cast δεν είναι ήδη στην μορφή thumbnail, πατάμε 
κλικ στο κουμπί Cast View Style 

 

 
 

2. στη μορφή thumbnail στο παράθυρο Cast, δεξί-κλικ σ’ ένα άδειο cast 
          member και διαλέγουμε Import 

3. πηγαίνουμε σ’ ένα αρχείο πολυμέσων, διαλέγουμε το αρχείο και κλικ 
          στο κουμπί Import 

 cast mem ρο Cast. 

2.7 Sprites 

 πώς τα 
ast membe σε μια Macromedia Director MX2004 ταινία. 

 
Sco ε πότε αυτό εμφανίζεται στην ταινία μας. 

Γενικές ιδιότητες των sprites 
 

Χρησιμοποιούμε το κουτί διαλόγου Sprite Preferences, για να ελέγχουμε 
τον τρόπο που συμπεριφέρονται τα sprites και εμφανίζονται στο παράθυρο 
Score και πάνω στο Stage. 
 Για να αλλάξουμε τις ιδιότητες σ’ ένα sprite : 

Διαλέγουμε Edit > Preferences > Sprite 

Το ber τώρα εμφανίζεται στο παράθυ
 

 
Ένα sprite, είναι ένα αντικείμενο το οποίο ελέγχει πότε, πού και

c
Π

rs εμφανίζονται 
ολλαπλά sprites, μπορούν να χρησιμοποιούν το ίδιο cast member. 

Χρησιμοποιούμε το Stage να ελέγχουμε πού ένα sprite εμφανίζεται και το
re για να ελέγχουμ
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2.8 Property Inspector 
 

Κάθε cast member και κάθε sprite σε μια ταινία, έχει ιδιότητες. 
Μπορούμε να εμφανίσουμε ή να αλλάξουμε αυτές τις ιδιότητες 
ρησιμοποιώντας τον Property inspector. Επίσης, η τρέχον ταινία έχει ένα 
σετ ιδιοτήτων. Ο Property inspector εμφανίζει ένα μενού της ταινίας όπου 
μπορούμε να επεξεργαστούμε τις ιδιότητες.  
 
Για να διαλέξουμε ανάμεσα σε μια μορφή λίστας και σε μια γραφική : 

1. εάν ο Property inspector δεν είναι ήδη εμφανίσιμος, διαλέγουμε  
Window > Property inspector 

2. κοντά στην κορυφή του Property inspector, πατάμε κλικ στο   κουμπί 
List View Mode  

 

χ

 
Για να δείξουμ

 πατάμε
ε περισσότερες πληροφορίες στο Property inspector : 
 κλικ στο βελάκι στο Property inspector 

 

 
 

Stage Size : διαλέγουμε μια τιμή για το Ύψος και Πλάτος για το μέγεθος   
του Stage 
Channels :  αντιπροσωπεύει τον αριθμό των κα

 :
ναλιών στο Score 

olorC   εισάγουμε μια RGB τιμή για το χρώμα στο Stage ή διπλό κλικ στο 
ικονίδιο του χρώματος για να διαλέξουμε χρώμα 
alette :

ε
P   διαλέγουμε παλέτα χρώματος για την ταινία 
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2.9 Bitmaps 
 

Τα δυαδικά αρχεία εικόνας (bitmaps) και οι διανυσματικές μορφές 
(vector sha es) είναι οι δύο ύρ οι τ ποι γραφικ ν παραστάσεων που 
χρησιμοποιούνται με Macromedia Director MX2004. Ένα δυαδικό αρχείο 
εικόνας (bitmap) καθορίζει μια εικόνα, ως πλέγμα των χρωματισμένων 
pixels (εικονοκυττάρων) και αποθηκεύει το

p κ ι ύ ώ

 χρώμα για κάθε pixel στην 
ικόνα. Μια διανυσματική μορφή (vector shape) είναι μια μαθηματική 

 της 
τικά 

γνωρί  να είναι εκφρασμένο μαθηματικά.  

 τις μικρές αλλαγές σε ένα δυαδικό αρχείο 
ικόνας με την έκδοση των ενιαίων pixels (εικονοκυττάρων), αλλά η 
επαναταξινόμηση της εικόνας μπορεί να προκαλέσει τη διαστρέβλωση, 
καθώς τα pixels ανακατανέμονται.  Anti-aliasing είναι ένα χαρακτηριστικό 
γνώρισμα του Director που συνδυάζει τα χρώματα του δυαδικού αρχείου 
εικόνας με τα χρώματα υποβάθρου γύρω από τις άκρες, για να κάνει την 
άκρη να εμφανιστεί ομαλή αντί οδοντωτού. Μια διανυσματική μορφή είναι 
η πιο κατάλληλη για μια απλή, ομαλή, καθαρή-ματιά εικόνας.  

ε
περιγραφή μιας γεωμετρικής μορφής που περιλαμβάνει το πάχος
γραμμής, το χρώμα γεμίσματος και τα πρόσθετα χαρακτηρισ

σματα της γραμμής που μπορεί
Bitmaps, ταιριάζουν με τις συνεχείς εικόνες τόνου όπως οι φωτογραφίες. 

Μπορούμε εύκολα να κάνουμε
ε

 

 
Ένα δυαδικό αρχείο εικόνας (bitmap) απαιτεί περισσότερη RAM και 

ελεύθερο χώρο στο δίσκο από μια συγκρίσιμη διανυσματική μορφή.  Εάν  
δεν συμπιέζονται, τα δυαδικά αρχεία εικόνας παίρνουν περισσότερο από τις  
διανυσματικές μορφές για να μεταφορτώσουν από το Διαδίκτυο.   

Ευτυχώς, το Director προσφέρει τον έλεγχο συμπίεσης για να μειώσει το 
μέγεθος των δυαδικών αρχείων εικόνας μέσα στην ταινία που συσκευάζετε 

ά 
ε 

 δημοφιλή 

ο Paint περιλαμβάνει 

 

για  να παίξουμε στον Ιστό. Μπορούμε να δημιουργήσουμε τα δυαδικ
όνας στο παράθυρο Paint ή να τα εισαγάγουμε από οποιοδήποταρχεία εικ

από τους δημοφιλείς συντάκτες  εικόνας στα περισσότερα από τα
σχήματα, συμπεριλαμβανομένου του GIF και JPEG.  Το Director μπορεί 
επίσης να εισαγάγει  τα δυαδικά αρχεία εικόνας με τα άλφα στοιχεία 
καναλιών (διαφάνεια) και κινούμενες GIF. Το παράθυρ
μια ποικιλία εργαλείων για επεξεργασία των bitmaps. 
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Εισάγοντας bitmaps 

 μειωμένα 
. Μέσα στο Director, μπορούμε να κάνουμε τις υψηλής ευκρίνειας 

εικόνες στο σωστό μέγεθος, αλλά αυτό θα μειώσει την ποιότητα της 
εικόνας. Επίσης, οι υψηλής ευκρίνειας εικόνες χρησιμοποιούν το πρόσθετο 
διάστημα μνήμης και αποθήκευσης.  

Εάν εργαζόμαστε με μια υψηλής ευκρίνειας , την μετατρέπουμε 
μετ

 
Η εισαγωγή των δυαδικών αρχείων εικόνας είναι παρόμοια με την 

εισαγωγή άλλων τύπων μέσων. Εάν εισάγουμε ένα δυαδικό αρχείο εικόνας 
με μια παλέτα ή ένα βάθος χρώματος διαφορετική απ’ αυτή της τρέχοντας 
ταινίας, το πλαίσιο διαλόγου Image Options εμφανίζεται. Πρέπει να 
επιλέξουμε να εισαγάγουμε το δυαδικό αρχείο εικόνας στο αρχικό βάθος 
χρώματός της ή στο τρέχον βάθος χρώματος συστημάτων. Εάν εισάγουμε 
μια 8-bit εικόνα, έχουμε την επιλογή της εισαγωγής της παλέτας χρώματος 
της εικόνας ή η εικόνα σε μια παλέτα που είναι ήδη σε Director.  

Στο Director μπορούμε να εισαγάγουμε τις εικόνες με τα άλφα 
αποτελέσματα καναλιών (διαφάνεια), τα οποία είναι 32- bit. Εάν μειώνουμε 
την εικόνα σε ένα βάθος χαμηλότερου χρώματος, Director αφαιρεί όλα τα 
άλφα στοιχεία καναλιών.  

Κατά την εισαγωγή των bitmaps, πρέπει πάντα να θεωρήσουμε ότι 
επιδεικνύουν στην οθόνη στο ψήφισμα του οργάνου ελέγχου μας (γενικά 72 
έως 96 σημεία ανά ίντσα). Οι εικόνες υψηλού-ψηφίσματος που τοποθετούμε 
στο Stage σε Director να εμφανιστούν πολύ μεγαλύτερες από ότι 
αναμένουμε. Άλλες εφαρμογές, ιδιαίτερα εκείνοι που στρέφονται στη 
δημιουργία των εικόνων για την τυπωμένη ύλη, αφήνουν εμάς να 
ργαζόμαστε στην οθόνη με τις υψηλής ευκρίνειας εικόνες σταε
μεγέθη

εικόνα
αξύ 72 και σε 96 σημεία ανά ίντσα με το πρόγραμμα εικόνα-επεξεργασία 

πριν να την εισάγουμε στο Director.  
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Το Director υποστηρίζει ο χρόνο εκτέλεσης για τα 
σωτερικά cast members που εισάγονται μέσω του Standard ή του Include 

Ori

mber είναι 
μεγ

edia Shockwave ή έναν προβολέα (εάν η επιλογή 
συ

ι σ έ

στο παράθυρο Paint γίνεται ένα cast 
me

 στο Stage. 
 
Για ν’ ανοίξουμε το παράθυρο Paint, κάνουμε ένα από τα ακόλουθα:

 τη συμπίεση JPEG στ
ε

ginal Data για τις επιλογές εισαγωγών Editing. Ένα αρχείο JPEG που 
εισήγαγε με καθεμία αυτών των επιλογών περιέχει και τα αρχικά 
συμπιεσμένα κομμάτια και τα αποσυμπιεσμένα κομμάτια. Αφότου 
εισάγεται, το αρχείο JPEG αποσυμπιέζει στο περιβάλλον δημιουργίας.  

Το μέγεθος των cast members, επιδεικνύει το μέγεθος του member στην 
RAM αφότου αποσυμπιέζεται. Η τιμή της RAM που απαιτείται για να 
επιδείξει ένα αρχείο JPEG είναι μεγαλύτερο από το μέγεθός του σε δίσκο, 
έτσι μπορούμε να αναμείνουμε ότι το μέγεθος του JPEG cast me

αλύτερο στο παράθυρο Cast Properties.  
 Το Director εκμεταλλεύεται τα συμπιεσμένα στοιχεία JPEG στο χρόνο 

εκτέλεσης. Τα αρχικά συμπιεσμένα κομμάτια στοιχείων σώζονται στην 
περιεκτικότητα σε Macrom
μπίεσης Shockwave είναι ανοικτή). Εάν εκδίδετε το μέλος μέσα στο 

Director στο παράθυρο Paint, το συμπιεσμένο στοιχείο χάνεται.  
Μια επιφυλακή εμφανίζεται προτού να επικαλυφθεί το στοιχείο.  
Εάν η επιλογή συμπίεσης Shockwave είνα  ανοικτή, Director υμπι ζει 
επίσης τα δυαδικά αρχεία εικόνας στο σχήμα JPEG. 
 
2.10 Το παράθυρο Paint 
 

Το παράθυρο Paint, έχει ένα πλήρες σύνολο εργαλείων και μελανιών 
χρωμάτων για τη δημιουργία και την αλλαγή των bitmap cast members για 
τις ταινίες. Οτιδήποτε σχεδιάζουμε 

mber. Όταν κάνουμε μια αλλαγή σ’ ένα cast member στο παράθυρο 
Paint, η εικόνα στο παράθυρο Cast είναι αμέσως ενημερωμένη, καθώς είναι 
cast member οπουδήποτε εμφανίζεται

 
 
• διαλέγουμε Window > Paint 
• κλικ στο εικονίδιο Paint window στην γραμμή εργαλείων 
• πατάμε Control-5 (Windows) ή Command-5 (Macintosh) 
• διπλό - κλικ σ’ ένα bitmap sprite στο Stage ή στο Score, ή διπλό - κλικ στο 
cast member του sprite στο Cast window. 
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2.1

κλικ δ ι
 λ

1 Τα εργαλεία του παράθυρου Paint 
 

Στο βέλος που βλέπουμε στη χαμηλότερη γωνία ενός εργαλείου, 
κάνουμε και συγκρατούμε το ποντίκι για να επι είξε  τις υπέρ-
εμφανιζόμενες επιλογές των επι ογών για εκείνο το εργαλείο. 

 
Για επιλογή μιας περιοχής τυχαίου σχήματος, κάνουμε ένα από τα εξής: 

   • κλικ στο εργαλείο Lasso στο Paint window, και τραβάμε για να 
εσωκλείσει τα pixels που θέλουμε να επιλέξουμε, το Lasso διαλέγει μόνο 
τόσα pixels όσο ένα χρώμα το οποίο είναι διαφορετικό από αυτό που ήταν 
όταν αρχίσαμε να το σύρουμε 

• πιέζουμε Alt (Windows) ή Option (Macintosh) ενώ σύρουμε για να 
δημιουργήσουμε ένα πολύγωνο 

• κλικ στο εργαλείο Lasso και κρατάμε πατημένο το ποντίκι για να 
 μενού pop-up 
ή περιοχή, κάνουμε ένα από τα ακόλουθα: 

διαλέξουμε νέα ρύθμιση από το
Για να διαλέξουμε μια κανονικ

 • κλικ και σύρουμε το εργαλείο Marquee στο Paint window 
•διπλό-κλικ στο εργαλείο Marquee για να διαλέξουμε  bitmap 
• κλικ στο εργαλείο Marquee και πατημένο το ποντίκι να διαλέξουμε 
νέα ρύθμιση από το μενού pop-up 

Για να αλλάξουμε τη θέση του σημείου εγγραφής, κάνουμε ένα από τα εξής: 

      • κλικ στο Registration Point εργαλείο και κλικ στο spot που θέλουμε 

με το 
της εικόνας 

els 

να βάλουμε το σημείο registration 
• διπλό-κλικ στο Registration Point εργαλείο να βάλου

registration σημείο στο κέντρο 
Για να σβήσουμε , κάνουμε ένα από τα εξής:  

x          • κλικ και σύρουμε το Eraser εργαλείο να σβήσει τα pi

   • διπλό-κλικ στο Eraser εργαλείο να σβήσει το cast member 
 
 

Για να μετακινήσουμε την όψη του Paint window, κάνουμε ένα από τα εξής: 
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    να κινήσουμε την τρέχουσα 
θέσ

• κλικ και σύρουμε το Hand εργαλείο, 
η της εικόνας στο Paint window. 

• Shift-σύρουμε να κινήσουμε ίσια οριζόντια ή κάθετα  
Για να μεγεθύνουμε ή να σμικρύνουμε μια περιοχή:  

       • κλικ στο Magnifying Glass εργαλείο και κλικ στο Paint window να 
μεγεθύνει, Shift-κλικ να σμικρύνει 
Για δειγματοληψία χρώματος σ’ ένα cast member: 

     1. κλικ στο εργαλείο Eyedropper 
2. κάνουμε ένα από τα παρακάτω: 

 

o κλικ σ’ ένα χρώμα ως foreground 
Shift-κλικ σ’ ένα χρώμα ως background 

 Alt-κλικ (Windows) ή Option-κλικ (Macintosh) για 
χρώμα ως gradient 

Για να γεμίσουμε τα τρέχων pixels το ίδιο χρώμα με το foreground 

    • κλικ στο εργαλείο Bucket και κλικ στην περιοχή που θέλουμε να 
γεμίσουμε 

• ανοίγουμε Gradient Settings dialog box, διπλό-κλικ στο εργαλείο 
Bucket 

Για να εισάγουμε bitmap κείμενο, κάνουμε ένα από τα εξής: 
 

       • κλικ στο εργαλείο Text, έπειτα κλικ στο Paint window και  
            

α. Πριν κάνουμε κλικ έξω από το 

    αρχίζει η γραφή 
• διαλέγουμε μορφή των χαρακτήρων, Modify > Font command 
Το Bitmap text είναι σαν μια εικόν
text box, μπορούμε να επεξεργαστούμε το κείμενο που γράψαμε 
χρησιμοποιώντας το Backspace (Windows) ή Delete (Macintosh). 
Όταν κάνουμε κλικ έξω από το text box, δεν μπορούμε να 
επεξεργαστούμε το bitmap text. 

Για να σχεδιάσουμε μια γραμμή 1-pixel στο τρέχων foreground: 
 

     • κλικ στο εργαλείο Pencil και σύρουμε στο Paint window. Να 
σχεδιάσουμε τη γραμμή  οριζόντια ή κάθετα, Shift+κλικ και σύρουμε 
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Για να σχεδιάσουμε σχήματα ή γραμμές: 
• κά

και  ορθογώνιο σε τετράγωνο, Shift-
κλικ κ

νουμε κλικ και σύρουμε τα εργαλεία shape, να σχεδιάσουμε γραμμές 
οριζόντιες ή κάθετες, οβάλ σε κύκλο 

αι σύρουμε 

 
 
Για estination χρώμα : 
• κά ένα foreground 
χρώμα, κλ

 να διαλέξουμε ένα χρώμα foreground και  d
νουμε κλικ στο color box στα αριστερά, διαλέγουμε 

ικ στο color box στα δεξιά, διαλέγουμε  ένα destination χρώμα 

 
Για να διαλέξουμε foreground και background χρώματα: 
• 
πρωτεύ
χρησιμοποιούμε το μενού Foreground Color pop-up να διαλέξουμε το 

ον χρώμα   

 
• ξουμε το 

Για να πό τα 
εξής: 
• για 
στο με

χρησιμοποιούμε το μενού Background Color pop-up, να διαλέ
δευτερεύον χρώμα 

 διαλέξουμε ένα pattern για foreground χρώμα , κάνουμε ένα α

να αλλάξουμε την παλέτα pattern,διαλέγουμε Pattern Settings κάτω 
νού Patterns pop-up 

 
 
Για να διαλέξουμε μια πιο λεπτή γραμμή, κάνουμε ένα από τα εξής: 
• κλικ στο κουμπί Καμία, 1, 2, ή 3-Pixel Line button 
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• διπλό-κλικ στο κουμπί Other Line Width για να ανοίξει το Paint Window 

ουμπί Color Depth, για να ανοίξει το Transform Bitmap 
dialog box. 

Preferences dialog box και διαλέγουμε ένα πάχος της γραμμής 
Για να αλλάξουμε το color depth ενός τρέχων cast member: 
• διπλό-κλικ στο κ

 
Για να διαλέξουμε Paint window ink: 

θύρου • διαλέγουμε τύπο του ink από το  Ink pop-up menu δεξιά του παρα

 

 
2.12 Το εργαλείο Lasso    
 

Χρησιμοποιούμε το εργαλείο Lasso, για να διαλέξουμε μη κανονικές 
περιοχές ή πολύγωνα. Αφού διαλέξουμε την περιοχή, αυτή μπορεί να 
συρθεί, αποκοπεί, αντιγραφεί, καθαριστεί, ή  με εντολές στην 

φορετικό από το χρώμα του εργαλείου Lasso που ήταν 

pop-up, για να αλλάξουμε τις ρυθμίσεις. 

ική περιοχή με το εργαλείο Lasso:

 τροποποιηθεί
μπάρα Paint toolbar. Το εργαλείο Lasso, επιλέγει μόνο τόσα pixels από ένα 
χρώμα που είναι δια
όταν εμείς  πρώτα αρχίσαμε να σύρουμε αυτό. Χρησιμοποιούμε το μενού 
Lasso 

 
Για να διαλέξουμε μη κανον  
• σύρουμε με το εργαλείο Lasso για να εσωκλείσουμε τα pixels που θέλουμε 
να διαλέξουμε  
 
Για να διαλέξουμε μια πολυγωνική περιοχή με  εργαλείο Lasso: το  

 στο 

3. διπλό-κλικ στο τελευταίο σημείο 
 

Για να αλλάξουμε τις ρυθμίσεις για το εργαλείο Lasso :

1. πιέζουμε Alt (Windows) ή Option (Macintosh), ενώ κάνουμε κλικ
πρώτο σημείο 

2. κλικ στα επιθυμητά σημεία 

 
1. κρατάμε πατημένο το ποντίκι ενώ ο δείκτης είναι στο εργαλείο Lasso  
2. διαλέγουμε μία από τις ακόλουθες επιλογές από το μενού Lasso : 
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Shrink το lasso για να σφίξει γύρω από το επιλεγμένο αντικείμενο 
έτσι ώστε μόνο το αντικείμενο επιλέγεται. 
No shrink μας αφήνει να επιλέξουμε την ολόκληρη περιοχή που 

μένη περιοχή. 
See Thru Lasso

σέρνουμε γύρω. Το λάσο επιλέγει οποιοδήποτε είναι μέσα στην 
επιλεγ

 αναγκάζει την επιλογή μας να γίνει διαφανή, σαν την 
επίδραση μελανιού Transparent που εφαρμόστηκε. 

 

2.13 Το εργαλείο Marquee    
 

Το εργαλείο Marquee επιλέγει το έργο που σχεδιάζουμε στο παράθυρο 
Paint. Αφού επιλέξουμε το έργο τέχνης μας, μπορεί να συρθεί, αποκοπεί, 
αντιγραφεί, καθαριστεί, ή τροποποιηθεί με τις εντολές στη μπάρα εργαλείων 
Paint. Χρησιμοποιούμε το μενού Marquee για να αλλάξουμε τις ρυθμίσεις. 
 
 Για να διαλέξουμε με το εργαλείο Marquee: 

ια ιλεγμένη περιοχή  
ια να διαλέξουμε την τρέχουσα bitmap:

• σύρουμε για να διαλέξουμε μ επ
Γ   
• διπλό-κλικ στο εργαλείο Marquee 
Για να κινήσει μια επιλογή, κάνουμε ένα από τα εξής:  
• κλικ και  σύρουμε την επιλογή  
• Shift-σύρουμε να ορίσουμε την κίνηση οριζόντια ή κάθετα 
• χρησιμοποιούμε το βέλος να κινήσουμε την επιλογή ένα pixel την φορά 
Για να κάνουμε αντίγραφο του έργου που διαλέξαμε με το εργαλείο 
Marquee: 
• κρατάμε πατημένο Alt (Windows) ή Option (Macintosh), ενώ σύρουμε το 
επιλεγμένο 
Για να αλλάξουμε τις ρυθμίσεις του marquee : 
• κλικ στο εργαλείο Marquee, κρατάμε πατημένο το ποντίκι και  διαλέγουμε 
ία από τις ακόλουθες επιλογές : 

 από το 

 αφήνει να επιλέξουμε όλα μέσα στη σκηνή 
ω από το αντικείμενο με τον ίδιο τρόπο 

γει pixel σύμφωνα με το χρώμα του 
ε να σύρουμε 

 

μ
Shrink αναγκάζει το ορθογώνιο για να στενέψει γύρω
επιλεγμένο έργο 
No Shrink μας
Lasso σφίγγει τη σκηνή γύρ
όπως το εργαλείο Lasso και επιλέ
pixel κάτω από τη διαγώνια γραμμή όταν αρχίσαμ
See Thru Lasso τροποποιεί τη λειτουργία επιλογής έτσι ώστε pixel 

δεν με το ίδιο χρώμα με το πρώτο pixel που επιλέγεται και 
συμπεριλαμβάνεται στην επιλογή 
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2.14 Το εργαλείο Airbrush     
 

Το
γεμίζε
αποτε
παράθ
ημεί .  
Εάν κρατάμε πατημένο το ποντίκι όταν τοποθετείται ο δείκτης στο 

ιζόμενες επιλογές Airbrush εμφανίζονται. 
άθε μια από τις πέντε τοποθετήσεις στις υπέρ-εμφανιζόμενες επιλογές 

μπο

ια να χρησιμοποιήσουμε το εργαλείο Airbrush:

 εργαλείο Airbrush ψεκάζει το τρέχων επιλεγμένο χρώμα, μελάνι, και 
ι το σχέδιο. Για να τροποποιήσει τον ψεκασμό, επιλέγουμε τα 
λέσματα μελανιού από τις υπέρ-εμφανιζόμενες επιλογές Ink στο 
υρο Paint. Όσο περισσότερο κρατάμε το εργαλείο Airbrush σ’ ένα 
ο, τόσο περισσότερο αυτό συμπληρώνει την περιοχήσ

εργαλείο Airbrush, οι υπέρ-εμφαν
Κ

ρεί να καθοριστεί, έτσι μπορούμε να έχουμε διάφορους τύπους 
ψεκασμών διαθέσιμους χωρίς το άνοιγμα του πλαισίου διαλόγου Airbrush 
Settings.  
 
Γ  

ό μέσα στο παράθυρο Paint • κλικ στο εργαλείο Airbrush και σύρουμε αυτ
Για να καθορίσουμε τις ρυθμίσεις airbrush:  

1. κλικ στο εργαλείο Airbrush και κρατάμε πατημένο το ποντίκι 
τικείμενο που θέλουμε να καθορίσουμε 

και διαλέγουμε Settings από το μενού 
ς στο κείμενο 

κείμενο διαλόγου Airbrush Settings. 

τει μια περιοχή με το χρώμα. Για να αλλάξει τη ροή, σύρουμε 

την περιοχή. 
6. θ

γίνουν οι ψεκασμοί airbrush.  
7. ρινίσουμε 

 

2. διαλέγουμε το menu για το αν
ρυθμίσεις 

3. ανοίγουμε το menu ξανά 
Airbrush pop-up. Εισάγουμε τιμές για τις επιλογέ
διαλόγου Airbrush Settings. 

Επίσης, μπορούμε να κάνουμε διπλό-κλικ στο εργαλείο Airbrush για να 
ανοίξει το 

4. χρησιμοποιούμε το Flow Rate για έλεγχο πόσο γρήγορα το airbrush 
καλύπ
το Flow Speed. 

5. χρησιμοποιούμε το Spray Area slider για να θέσουμε το μέγεθος των 
airbrush για να ψεκάσουμε 
χρησιμοποιούμε το Dot Size slider για να έσουμε το μέγεθος των 
σημείων όπου θα 
χρησιμοποιούμε τις ακόλουθες Dot επιλογές για να διευκ
πώς τα σημεία ψεκάζονται από το airbrush: 
Uniform Spray το airbrush ψεκάζει στο κανονικό μέγεθος 
Random Sizes ψεκάζει τις τυχαία μεγέθους πτώσεις  
Current Brush οι πτώσεις ψεκασμών διαμόρφωσαν όπως το   
τρέχον airbrush.  
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2.15 Το εργαλείο Brush  
 

Χρησιμοποιούμε το εργαλείο Brush για να βουρτσίσουμε τα κτυπήματα 
με το τρέχον χρώμα, μελάνι και γεμίζουμε το σχέδιο. Για να επιλέξουμε το 
διαφορετικό μέγεθος και την μορφή βουρτσών, χρησιμοποιούμε το πλαίσιο 
διαλόγου Brush Settings. Οι επιλογές που κάνουμε μέσα στο πλαίσιο 
διαλόγου Brush Settings ορίζεται στο στοιχείο επιλογών στις υπέρ-
εμφανιζόμενες επιλογές. Κάθε μια από τις πέντε τοποθετήσεις στις υπέρ-
εμφανιζόμενες επιλογές μπορεί να καθοριστεί έτσι ώστε να μπορούμε να 
έχουμε διάφορους τύπους ψεκασμών διαθέσιμους, χωρίς άνοιγμα του 
πλαισίου διαλόγου Brush Settings.  
 
Για να χρησιμοποιήσουμε το εργαλείο Brush: 
 κλικ στο • εργαλείο Brush και σύρουμε αυτό μέσα στο παράθυρο Paint 
Για να αλλάξουμε τις ρυθμίσεις του  brush: 

1. κλικ στο εργαλείο Brush και κρατάμε πατημένο το ποντίκι  
ενο για το οποίο θέλουμε να2. επιλέγουμε το menu για το αντικείμ  

Χρ έγχουν το 
bru

 

ω βέλος, κινεί την brush μορφή πάνω ή κάτω ένα   
pixel 

καθορίσουμε τις ρυθμίσεις 
3. ανοίγουμε το menu ξανά και διαλέγουμε Settings από το μενού Brush 

pop-up. Εισάγουμε τιμές για τις επιλογές στο Brush Settings dialog 
box. 

Μπορούμε επίσης να κάνουμε διπλό-κλικ στο εργαλείο Brush για να ανοίξει 
το Brush Settings dialog box. 

 4. για να επιλέξουμε από την προεπιλογή brush άλλες μορφές, 
διαλέγουμε Standard από το menu και κλικ σε μια μορφή brush 
παρακάτω στο pop-up menu. 

5. για να δημιουργήσουμε ένα νέο brush σχήμα, διαλέγουμε Custom από 
το pop-up menu και διαλέγουμε το brush σχήμα που θέλουμε να 
τροποποιήσουμε από το pop-up menu. 

6. επεξεργαζόμαστε το τρέχων brush σχήμα, κάνοντας κλικ στην 
ενισχυμένη εικόνα του brush σχήμα. Κλικ σ’ ένα κενό pixel το 
γεμίζουμε and κλικ σ’ ένα γεμισμένο pixel το καθιστά κενό. Κλικ έξω 
από το Brush Shapes dialog box τοποθετούνται τα pixels στην οθόνη 
στο σημείο που κάναμε κλικ.  
ησιμοποιούμε, ένα από τα ακόλουθα να εντολές που ελ
sh: 
Το δεξί και αριστερό  βέλος, κινεί την brush μορφή ένα pixel  

 δεξιά ή αριστερά
Το πάνω και κάτ

 33



Το μαύρο και άσπρο τ ά
brush shape (π.χ., μαύρ

ετρ γωνο, αντιστρέφει τα χρώματα του   
ο γίνεται άσπρο και άσπρο γίνεται μαύρο). 

ες στο παράθυρο Paint:

Copy αντιγράφει την brush μορφή στο Clipboard. 
Paste επικόλληση του brush σύνολο του custom των brush   
μορφών 

 
2.16 Οι χάρακες στο παράθυρο Paint 
 

Το παράθυρο Paint έχει κάθετους και οριζόντιους χάρακες, οι οποίοι μας 
βοηθούν για να ευθυγραμμίσουμε και να ταξινομήσουμε το έργο μας που 
σχεδιάζουμε. 
 
Για να εμφανίζουμε ή να κρύβουμε τους χάρακ  

 μηδέν, κάνουμε ένα από τα 
• διαλέγουμε View > Rulers 
Για να αλλάξουμε την θέση του σημείου
ακόλουθα: 
• σύρουμε μόνο τον χάρακα στην κορυφή ή πλευρά του παραθύρου 
• σύρουμε μέσα στο παράθυρο να ευθυγραμμίσουμε το μηδέν σημείο μ’ ένα 

Μεγέθυνση και Σμίκρυνση στο παράθυρο Paint 

ειδικό σημείο του cast member 
 

 
Μπορούμε να χρησιμοποιήσουμε το εργαλείο Magnify ή τις Zoom 

εντολές στο  View menu, για να μεγεθύνουμε και να σμικρύνουμε στα 
τέσσερα επίπεδα ενίσχυσης.  
 
Για μεγέθυνση ή σμίκρυνση, κάνουμε ένα από τα ακόλουθα: 
• κλικ στο εργαλείο Magnify και κλικ στην εικόνα.  

Shift+κλικ για σμίκρυνση 
 o• διαλέγουμε Zoom In ή Zo m Out από το μενού των επιλογών του Paint 

παραθύρου 
• διαλέγουμε View > Zoom και διαλέγουμε το επίπεδο επεξεργασίας 
• πιέζουμε Control + Plus (+) πλήκτρο (Windows) ή Command + Plus (+) 
πλήκτρο (Macintosh) για μεγέθυνση, ή Control + Minus (-) πλήκτρο 
(W
(M
• C , για 
να μεγ
 

indows) ή Command + Minus (-) πλήκτρο 
acintosh) για σμίκρυνση 
ontrol-κλικ (Windows) ή Command-κλικ (Macintosh) στην εικόνα

εκριμένο σημείο εθύνει σ’ ένα συγκ
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ια να επιστρέψουμε στο κανονικό μέγεθος, κάνουμε τα εξής:Γ  

νας στην πάνω δεξιά γωνία 
διαλέγουμε View > Zoom > 100% 

 

Η μπάρα εργαλείων στην κορυφή του παραθύρου Paint περιέχει τα 
όνας 

σουμε οποιαδήποτε από αυτές τις επιλογές, 

επιλογή 

λεία Marquee και Lasso. 
ε Lingo ή JavaScript μπορούμε να κάνουμε flip και rotate bitmaps 

κάνοντας flipp

π

• κάνουμε κλικ στο κανονικό-μέγεθος της εικό
• 

Flipping, rotating και επιδράσεις σε bitmaps 
 

κουμπιά για να εφαρμόσει τα αποτελέσματα στα δυαδικά αρχεία εικ
(bitmaps). Πριν χρησιμοποιή
πρέπει να επιλέξουμε μέρος της εικόνας bitmap με το εργαλείο Lasso ή 
Marquee.  
Δράσεις, που αλλάζουν τη μορφή της εργασίας επιλογής, όταν η 
γίνεται με το Εργαλείο Marquee. Δράσεις που αλλάζει χρώμα μέσα στην 
επιλογή, λειτουργούν με τα Εργα
Μ

ing και rotating σε bitmap sprites. 
 

Ε εξεργασία εικόνας 
 

1. διαλέγουμε ένα μέρος από μια bitmap στο Paint window με το 
εργαλείο Marquee 

2. χρησιμοποιούμε μία από τις παρακάτω ενέργειες: 
orizontal,  flip(αντικατοπτρίζω), κλικ στο κουμπί Flip H

 κουμπί Flip Vertica
 flip δεξιά 

l, flip πάνω προς κάτω προς αριστερά, ή κλικ στο
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 rotate (περιστροφή) την επιλογή κατά 90° αριστερόστροφα ή 90° 
δεξιόστροφα, κλικ στα κουμπιά Rotate Left ή Rotate Right, 
αντίστοιχα 

 
 rotate (περιστροφή) την επιλογή προς οποιαδήποτε κατεύθυνση  , 
κλικ στο κουμπί Free Rotate, σύρουμε προς όποια κατεύθυνση 

 
 skew (λοξεύω) , κλικ στο κουμπί Skew και σύρουμε 

 
 warp (σκεβρώνω) την μορφή της επιλεγμένης περιοχής , κλικ στο 
κουμπί Warp και σύρουμε 

 
 κλικ στο κουμπί Perspective και σύρουμε 

 
 για να δημιουργήσουμε εξωτερική γραμμή στην επιλεγμένη περιοχή, 
κλικ στο κουμπί Trace Edges 

 
Για να κάνουμε αλλαγές στο χρώμα της επιλεγμένης περιοχής: 
 

1. διαλέγουμε μια περιοχή από ένα bitmap cast member 
sso 

 
Smooth (χρησιμοποιείται μόνο σε 8-bit cast members) 

χρησιμοποιώντας είτε το εργαλείο Marquee είτε το εργαλείο La
2. κάνουμε ένα από τα παρακάτω: 

 πιο απαλό στις άκρες τις επιλεγμένης περιοχής, κλικ στο κουμπί

 
 για αντιστροφή των χρωμάτων, κλικ στο κουμπί Invert 

 
 για να μειώσουμε ή να ελαττώσουμε την φωτεινότητα της 
επιλεγμένης περιοχής, κλικ στο κουμπί Lighten Color ή Darken 
Color (δουλεύει μόνο σε 8-bit (256 color) εικόνες) 
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 για να γεμίσουμε με το τρέχων χρώμα foreground color, κλικ στο 
κουμπί Fill 

 
 

destination, κλικ στο κουμπί Switch Colors 
για να αλλάξουμε όλα τα pixels του foreground χρώματος με το 

 
 

cript 
σύνταξη 

υς. 
τελούμε απλές διαδικασίες που έχουν 

επιπτώσεις στο περιεχόμενο της ολόκληρης εικόνας. Αυτές οι διαδικασίες 
ι του πρώτου πλάνου που 
ς που εμφανίζεται σε ένα 

συγκεκριμένο cast member  με αυτό ενός  cast member. Κάθε μια από 
 

σιμοποιούμε Lingo ή JavaScript για να 
εκτελεστούν οι λεπτοί χειρισμοί των pixels μιας εικόνας ή για να 
δημιουργηθούν εξ ολοκλήρου νέες εικόνες. Όταν χρησιμοποιούμε κώδικα, 

οιες εικόνες 
πιδεικνύουμε. Μπορούμε να δημιουργούμε τις εικόνες βασισμένες στις 

θέλουμε

Τα vector shapes και οι εικόνες bitmaps είναι οι δύο κύριοι τύποι 
γραφικών παραστάσεων που χρησιμοποιούνται στο Macromedia Director 

ιγραφή μιας 
γεωμετρικής μορφής που περιλαμβάνει το πάχος της γραμμής, το χρώμα 

εικόνα ένων 
pixels α. 
 

2.17 Ελέγχοντας εικόνες bitmap με Lingo ή JavaS

 
Με Lingo ή JavaScript ελέγχουμε τις εικόνες bitmap με δύο τρόπο

Κατ' αρχήν, μπορούμε να εκ

περιλαμβάνουν την αλλαγή του υποβάθρου κα
χρωματίζεται εκτός από την αλλαγή της εικόνα

 άλλου
αυτές τις διαδικασίες χειρίζεται μια ιδιοκτησία της ολόκληρης εικόνας cast
member. Δεύτερον, μπορούμε να χρη

μπορούμε να είμαστε εξαιρετικά εύκαμπτοι σχετικά με π
ε
δυναμικές πληροφορίες, ή βασισμένοι σε οποιουσδήποτε παράγοντες 

 να περιλάβουμε. 
 
2.18 Vector Shapes 
 

MX2004. Ένα vector shape είναι μια μαθηματική περ

γεμίσματος (fill ) και πρόσθετα χαρακτηριστικά γνωρίσματα της γραμμής 
που μπορεί να εκφραστεί  από μαθηματική άποψη. Ένα δυαδικό αρχείο 

ν χρωματισμς (bitmap) καθορίζει μια εικόνα ως πλέγμα τω
και αποθηκεύει το χρώμα για  κάθε pixel στην εικόν
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Μπορούμε να δημιουργήσουμε Vector Shape στο παράθυρο 
Director, Vector Shape, 

του 
με το να καθορίσουμε τα σημεία κατευθείαν της 

γραμμής που περνά. Η μορφή μπορεί να είναι μια γραμμή, μια καμπύλη, ή  
μια ανοικτή ή κλειστή ανώμαλη μορφή που μπορούν να γεμίζουν με ένα 

go ή 
σουμε δυναμικά και να 

ελέγξουμε τις διανυσματικές μορφές. Μπορούμε να δημιουργήσουμε μια 
ιανυσματική μορφή εξ ολοκλήρου με  ή να τροποποιήσουμε ένα 

ηματικές 
, απαιτούν λιγότερο RAM και στο δίσκο χωρίζεται κατά 

ιαστήματα από μια ισοδύναμη εικόνα δυαδικών αρχείων εικόνας και 
μετ

υ

ι

 
ία. Μπορούμε επίσης να δημιουργήσουμε λαβές, 

ι οποίες είναι σημεία που καθορίζουν το βαθμό κυρτότητας μεταξύ 
λες είναι γνωστός ως Bιzier καμπύλες. Vertex χωρίς 

ια λαβή δημιουργεί μια γωνία.  

 ς

 
χρώμα ή μια κλίση. Μπορούμε επίσης να χρησιμοποιήσουμε Lin
σύνταξη JavaScript δυναμικά, για να δημιουργή

δ κώδικα
υπάρχον καθώς η ταινία παίζει. 

Επειδή οι διανυσματικές μορφές αποθηκεύονται ως μαθ
περιγραφές
δ

αφορτώνουν γρηγορότερα από το Διαδίκτυο.  
 

2.18.1 Σχεδιάζοντας vector shapes 
 

Δημιουργούμε τις διανυσματικές μορφές με τα εργαλεία σχεδίων στο 
παράθυρο Vector Shape. Μπορούμε να χρησιμοποιήσουμε το εργαλείο Pen 
για να δημιουργήσουμε μια ανώμαλη μορφή ή τα εργαλεία μορφών για να 
δημιουργήσουμε ορθογώνια και ελλείψεις. Μια διανυσματική μορφή μπορεί 
να περιβάλει πολλαπλάσιες καμπύλες και μπορούμε να χωρίσο με και να 
ενώσουμε τις καμπύλες. Οι ιδιότητες μορφής όπως το χρώμα γεμίσματος, το 
χρώμα κτυπήματος, και το πλάτος κτυπήματος τίθεντα  στο επίπεδο του 
cast-member  και όχι για τις μεμονωμένες καμπύλες.  

Όταν δημιουργούμε τις διανυσματικές μορφές, δημιουργούμε vertices, τα 
οποία είναι σταθερά σημε
ο
vertices. Αυτές οι καμπύ
μ

Καθώς σύρουμε τις διανυσματικές μορφές, οι λαβές ελέγχου 
εμφανίζονται vertices: στρογγυλά σημεία καμπυλών για vertices με τις 
λαβές και τα τετραγωνικά σημεία γωνιών για vertices χωρί  λαβές. 
 

 
• το πρώτο vertex σε μια καμπύλη είναι πράσινο 
• το τελευταίο vertex σε μια καμπύλη είναι κόκκινο 
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• όλα τα άλλα vertices είναι μπλε 
• μη επιλεγμένα vertices είναι στερεά  
 

 
• επιλεγμένα vertices είναι ασυμπλήρωτα  
 
Για ξ να ανοί ουμε το παράθυρο Vector Shape: 
• Select Window > Vector Shape 
 
 

Zooming in (μεγέθυνση) και zooming out (σμίκρυνση) στο παράθυρο 
pe Vector Sha

 
 

Χρησιμοποιούμε το εργαλείο Magnify ή Zoom εντολές στο the μενού 
View στο ζουμ μέσα ή έξω στα τέσσερα επίπεδα ενίσχυσης. 
 
Για μεγέθυνση ή σμίκρυνση, κάνουμε ένα από τα ακόλουθα: 
 
• διαλέγουμε View > Zoom και ύστερα διαλέγουμε το επίπεδο ενίσχυσης  
• δεξί-κλικ (Windows) ή Control-κλικ (Macintosh) και διαλέγουμε Zoom In 
ή Zoom Out από το μενού 
• π

φή:

ιέζουμε Control + το  Plus (+) πλήκτρο (Windows) ή Command + το Plus 
(+) πλήκτρο (Macintosh) για zoom in, ή Control + το Minus (-) πλήκτρο 
(Windows) ή Command + το Minus (-) πλήκτρο (Macintosh) για zoom out. 
 
Για επιστροφή στην κανονική μορ  
• δι ε  >

Χρησιμοποιούμε τα εργαλεία στο παράθυρο Vector Shape για να 
σύρουμε τις μορφές ελεύθερης-μορφής ή τους γεωμετρικούς αριθμούς.  
Μπορούμε να καθορίσουμε μια μορφή με το εργαλείο Pen με τη δημιουργία 
των σημείων καμπυλών ή γωνιών μέσω των οποίων περνά μια γραμμή. 

αλέγουμ  View > Zoom  100%. 
 

2.18.2 Τα εργαλεία σχεδιασμού των vector shapes 
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Για να σύρουμε τις κανονικές μορφές, χρησιμοποιούμε τα εργαλεία 
pse. Rectangle, Rounded Rectangle και Elli

 
 
Για να δημιουργήσουμε vector shape χρησιμοποιώντας το εργαλείο Pen: 

ο κουμπί New Cast Member 
σχεδιάζουμε: 

 
1. στο παράθυρο Vector Shape, κλικ στ
2. κλικ στο εργαλείο Pen και αρχίζουμε να 

 

 
 

 για να δημιουργήσουμε ένα σημείο γωνιών, κάνουμε κλ
για να δημιουργήσουμε ένα σημείο καμπυλών, κλικ και

ικ μια φορά  
  σύρουμε 

η Το σύρσιμο δημιουργεί τις λαβές ελέγχου που καθορίζουν πώς 
γραμμή κάμπτει μέσω του σημείου που καθορίζουμε.  

 για να περιορίσουμε ένα νέο σημείο σε κάθετο, οριζόντιο, ή μια 
γωνία 45°, κρατάμε πατημένο Shift και κάνουμε κλικ 

 
Για να σχεδιάσουμε χρησιμοποιώντας ένα βασικό εργαλείο shape: 
 

1. στο παράθυρο Vector Shape, κά
Member 

νουμε κλικ στο κουμπί New Cast 

ed ή Unfilled Rectangle, Rounded 

α, σύρουμε για 

 

 
 
 

2. διαλέγουμε το εργαλείο Fill
Rectangle, ή Ellipse 

3. κρατάμε πατημένο το ποντίκι για να αρχίσει ένα σχήμ
να σχεδιάσουμε και αφήνουμε το ποντίκι για να τελειώσει το σχήμα 

Για να περιορίσουμε ένα ορθογώνιο σε ένα τετράγωνο, ή για μια έλλειψη σε 
έναν κύκλο, κρατάμε πατημένο το πλήκτρο Shift καθώς σύρουμε. 
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Διαλέγοντας ρυθμίσεις γεμίσματος και γραμμών για 
vector shape

 
s 

 
Μπορούμε να χρησιμοποιήσουμε είτε τους ελέγχους στο παράθυρο 

Vector Shape είτε Lingo είτε τη σύνταξη JavaScript για να επιλέξουμε το 
ρώμα γεμίσματος της διανυσματικής μορφής, πλάτος και χρώμα γραμμών, 

μια 
ιανυσματική μορφή αλλά μέσα στο οριοθετώντας ορθογώνιο του cast 

ενο, δεν πρέπει 
α  οποιοδήποτε μέρος της διανυσματικής μορφής κάνετε τις 
ακόλουθες αλλαγές.  
 
Για να διαλέξουμε τις ρυθμίσεις fill και line:

χ
και χρώμα υποβάθρου. Το υπόβαθρο είναι η περιοχή έξω από 
δ
member.  

Επειδή μια διανυσματική μορφή είναι ένα ενιαίο αντικείμ
επιλέξετεν

 
 

1. ανοίγουμε ένα vector shape στο παράθυρο Vector Shape 
2. διαλέγουμε τις ρυθμίσεις fill και line χρησιμοποιώντας κατάλληλους 

έλεγχους στα αριστερά του παραθύρου 

 
   

o για να καθορίσουμε το πλάτος γραμμών, επιλέγουμε μια επιλογή 
μεγέθους σημείου από το μενού Line Width 

o ανοίγουμε ή κλείνουμε vector shapes, με την επιλογή Closed 
o διαλέγουμε χρώμα γραμμής (line), από το μενού Line Color 
o διαλέγουμε fill (γέμισμα) χρώμα, από το μενού Fill Color 
o διαλέγουμε background χρώμα, από το μενού Background Color 
o διαλέγουμε gradient fill χρώμα, από τις επιλογές Gradient Colors 
o διαλέγουμε τον τύπο fill, από τις επιλογές Fill type : No Fill, Solid, ή 

Gradient 
 

Επεξεργασία vector shape fills και strokes με Lingo ή JavaScript 
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Μπορούμ ε πώς ένα 
vector shape γεμίζει και strokes
 οι

ape. Αλλάζουμε τα vector shapes κινώντας , προσθέτοντας, ή 
δια

gistration, χρησιμοποιώντας είτε το παράθυρο Vector 

ipt 

ς τους και χρησιμοποιούμε 
μεθόδους σχετικές με τα shape vertices. 
• για να εμφανίσουμε μια λίστα που περιέχει την τοποθεσία καθενός vertex, 
χρησιμοποιούμε την ιδιότητα vertexList 
• για να προσθέσουμε ή να διαγράψουμε ένα vertex, χρησιμοποιούμε την 
μέθοδο addVertex() ή deleteVertex() 
• για να κινήσουμε ένα vertex ή vertex handle, χρησιμοποιούμε την μέθοδο 
moveVertex() ή moveVertexHandle() 
• για να προσθέσουμε ένα νέο σχήμα σ’ ένα vector shape, χρησιμοποιούμε 

ve() 

ε με κώδικα Lingo ή JavaScript να διευκρινίσουμ
. 

•  εντολές strokeColor και strokeWidth στις ιδιότητες των cast member 
• fillColor, fillMode, fillOffset και fillScale στις ιδιότητες cast member 
 

Επεξεργασία των vector shapes 
 

Για να επεξεργαστούμε vector shapes, χρησιμοποιούμε το παράθυρο 
Vector Sh

γράφοντας σημεία ελέγχου και αλλάζοντας την καμπύλη τους. 
Αλλάζουμε τον τρόπο που ένα vector shape τοποθετείται στο Stage 
κινώντας το σημείο re
Shape ή Lingo ή σύνταξη JavaScript. 
 

Ελέγχοντας vector shapes με Lingo ή σύνταξη JavaScr
  

Μπορούμε να χρησιμοποιήσουμε κώδικα για να τροποποιήσουμε ένα 
vector shape χρησιμοποιώντας τις ιδιότητέ

την μέθοδο newCur
• για να εμφανίσουμε registration point για το vector shape του cast member, 
ελέγχουμε την ιδιότητα regPointVertex 
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• γ
νται, ελέγχουμε την ιδιότητα originMode 

Το Macromedia D ο κείμενο που είναι 
ditable (μπορούμε να γράφουμε κατά την διάρκεια της ταινίας). 
Συ

σ

ό το οποίο οι πηγές είναι διαθέσιμες 
τον υπολογιστή του χρήστη.  
Επειδή τα αντί-

ευδώνυμα, ή λειαίνει, αυτό καθώς η ταινία παίζει, το κείμενο στο Director 
είν

 γραφικό. 

ήσει τα νέα cast member κείμενο 

τυο. 

της ταινίας μας, μπορούμε να 

γαλείων Director.  

Το κείμενο σε Director είναι editable όταν εργαζόμαστε στην ταινία μας 
και προαιρετικά, ενώ η ταινία παίζει.  

Μπορούμε επίσης, με κώδικα σε Lingo ή τη σύνταξη JavaScript να 
ελέγξουμε το κείμενο. Παραδείγματος χάριν, μπορούμε να 
χρησιμοποιήσουμε κώδικα για να εκδώσουμε το κείμενο στα υπάρχοντα 
cast members, διευκρινίζουμε τη μορφοποίηση κειμένων όπως η πηγή και 
το μέγεθος και ερμηνεύουμε τις σειρές που οι χρήστες εισάγουν.  

ια να εμφανίσουμε ή να διευκρινίσουμε το σημείο γύρω από ένα vector 
shape οι κλίμακες και περιστρέφο
 
2.19 Text 
 

irector MX2004 δημιουργεί τ
e
νδυάζουμε τα χαρακτηριστικά γνωρίσματα με οποιεσδήποτε από τις 

ικανότητες ζωτικότητας Director, όπως η περιστροφή, και μπορούμε να 
δημιουργήσουν θαυμάσια αποτελέ ματα κειμένων στις ταινίες Director μας.  

Μπορούμε να ενσωματώσουμε τις πηγές σε μια ταινία για να 
εξασφαλίσουμε ότι το κείμενο εμφανίζεται σε μια συγκεκριμένη πηγή όταν 
μια ταινία παραδοθεί, ανεξάρτητα απ
σ

 το Director δίνει το κείμενο στην πηγή επίδειξης και 
ψ

αι πολύ συμπαγή και φορτώνουν γρήγορα από το Διαδίκτυο.  
Το μεγαλύτερο μέρος υψηλής ποιότητας κείμενο που βλέπουμε στους 

browsers Ιστού είναι ένα GIF ή ένα JPEG
Το Director παρέχει πολλούς τρόπους να προσθέσει το κείμενο σε μια 

ταινία. Μπορεί ο καθένας να δημιουργ
μέσα σε Director ή το κείμενο εισαγωγών από μια εξωτερική πηγή όπως ένα 
έγγραφο που αποθηκεύεται στο διαδίκ

Μπορούμε να εισαγάγουμε τα σαφή έγγραφα κειμένων, RTF, ή HTML. 
Αφότου το κείμενο είναι μέρος 
σχηματοποιήσουμε το κείμενο με ποικίλους τρόπους με τη χρησιμοποίηση 
των σχηματοποιώντας ερ

Μπορούμε επίσης να δημιουργήσουμε τις συνδέσεις υπερκειμένων για 
οποιοδήποτε κείμενο.  
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Για να ενσωματώσουμε ένα font στην ταινία μας: 
 

1. διαλέγουμε Insert > Media Element > Font 
ο μενού Original Font, διαλέγουμε ένα font το οποίο είναι 

εφικτό με το σύστημά μας 

ή ο

Dir ς α τ

κλικ στο κουμπί Sizes για Bitmaps και 

 font που περιέχεται, 

υμε ακριβώς όποιον χαρακτήρα 

 
 ένα font με Lingo ή JavaScript σύνταξη:

2. από τ

Δεν μπορούμε να ενσωματώσουμε μια πηγή που δεν εγκαθίσταται στο 
σύστημά μας.  Δηλαδ , μόνο fonts τα ποία εμφανίζονται στο Original Font 
pop-up μενού είναι διαθέσιμα για να ενσωματωθούν. 

Στο New Font Name text box, το όνομα του font ακολουθείται από ένα 
αστερίσκο (*). Αυτό το όνομα εμφανίζεται σε όλα τα μενού των font στο 

ector. Σε πολλέ  περιπτώσεις, δεν πρέπει να λλάζουμε το όνομα ου 
font. 

3. για να περιλάβουμε τις εκδόσεις bitmaps της πηγής στα 
διευκρινισμένα μεγέθη, 
εισάγουμε τα μεγέθη σημείου που θέλουμε να περιλάβουμε, 
χωρισμένος από τα διαστήματα ή τα κόμματα. Παραδείγματος χάριν, 
εμείς να εισάγουμε  9 ..10 ..14 

4. για bold ή italic χαρακτήρες, διαλέγουμε Bold ή Italic 
5. για τροποποίηση των χαρακτήρων από το

διαλέγουμε μια επιλογή για Characters: 
Entire Set περιέχει κάθε χαρακτήρα (symbols, punctuation, 
numbers,κτλ) με το font. 
Partial Set μας αφήνει να διαλέξο
περιέχεται. Για να διαλέξουμε ένα group χαρακτήρων, διαλέγουμε 
Punctuation, Numbers, Roman Characters, ή Other. Εάν διαλέξουμε 
Other, εισάγουμε τους χαρακτήρες που περιέχονται στο text box στα 
δεξιά. 

Για να ενσωματώσουμε  
• χ

Για να δημιουργήσουμε text cast members στο Stage:

ρησιμοποιούμε την μέθοδο recordFont 
 
2.19.1 Δημιουργία text στο Director 
 
Το Director παρέχει  δύο τρόπους να δημιουργήσουμε text cast members:  

στο Stage ή μέσα στο παράθυρο Text 
 

 

1. διαλέγουμε το εργαλείο Text στην παλέτα Tool         
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2. σύρουμε τον text pointer δια μέσου στο Stage και αφήνουμε το 
ποντίκι να δημιουργήσουμε text cast member 

er εμφανίζεται στη πρώτη 

me στο Score 
 

3. εισάγουμε κείμενο, το νέο text cast memb
διαθέσιμη θέση στο τρέχων cast και το sprite είναι τοποθετημένο στο 
πρώτο κελί στο τρέχων fra

Για να δημιουργήσουμε text cast members στο παράθυρο Text: 
1. διαλέγουμε Insert > Media Element > Text 

Εάν το παράθυρο Text είναι ήδη ανοιχτό, κλικ στο κουμπί New  
Cast Member to create a new text cast member.    

 
 

2. εισάγουμε κείμενο στο παράθυρο Text 
Το κείμενο που εισάγουμε, εμφανίζεται στη πρώτη διαθέσιμη cast 
θέση, αλλά δεν τοποθετείται αυτόματα στο Stage. 

3. για να αλλάξουμε πλάτος του cast member, σύρουμε την μπάρα 
στην δεξιά άκρη του cast member 

 
 

 2.19.
 

Μπ
σώζει
(ASCI
διαδικ
έγγρα
ιαδίκ ικ στο κουμπί Διαδίκτυο στο πλαίσιο διαλόγου Import (File > 

L.  
ονται μέσα 

ε Link εξωτερικό αρχείο. 
έγγραφο HTML, το Director 
ετικέτες και παράμετροι, 

 
ς 

ίνακε θετημένους πίνακες. 
 Director αναγνωρίζει 
ισάγει τις εικόνες που 

2 Εισαγωγή ειμένο  

εισάγουμε

κ υ

ορούμε να  το κείμενο από οποιαδήποτε εφαρμογή που 
 το κείμενο με το πλούσιο σχήμα κειμένων (RTF), στο σαφές κείμενο 
I), ή από τα έγγραφα HTML. Χρησιμοποιούμε την τυποποιημένη 
ασία εισαγωγής με File > Import για να εισαγάγει οποιοδήποτε 
φο RTF, ASCII, ή HTML. Για να εισαγάγει ένα έγγραφο HTML από 
τυο, κλΔ

Import) και εισάγει ένα URL μέσα το παράθυρο κειμένου File UR
αι πάντα και αποθηκεύΤα αρχεία κειμένων και RTF εισάγοντ

το αρχείο ταινιών, ακόμα κι αν επιλέγουμσ
Όταν εισάγουμε το κείμενο από ένα 

αναγνωρίζει πολλές τυποποιημένες 
συμπεριλαμβανομένων των πινάκων και προσεγγίζουν τη μορφοποίηση. Το
Director δεν αναγνωρίζει τα ενσωματωμένα αντικείμενα εκτός από του
π ς και αυτό δεν υποστηρίζουν τους τοπο

Όταν εισάγουμε το κείμενο από ένα αρχείο RTF, το
την πιο τυποποιημένη μορφοποίηση RTF, αλλά δεν ε
ενσωματώνονται στο αρχείο.  
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2.19.3 Εισαγωγή κειμένου με Lingo ή JavaScript 
 
Για να εισάγουμε κείμενο με διάφορους τρόπους με κώδικα σε Lingo ή 
JavaScript: 
• για να εισάγουμε το κείμενο από ένα URL, χρησιμοποιούμε τη  μέθοδο 
etNetText ()   

 URL ή τον 
 text cast member και 

χρησιμοπο
του οποίο

δίσκο, χρησιμοποιούμε τη 
μέθοδο g
αρχείο, η  

ένου 
 

Το Director προσφέρει διάφορους τρόπους να εκδοθεί και να 
σχηματοποιηθεί το κείμενο.  

Μπορούμε να εκδώσουμε το κείμενο άμεσα στο Stage και το σχήμα αυτό 
χρησιμοποιεί το παράθυρο Text για να 
ότερο κείμενο περιβάλλον έκδοσης. 

g
• για να εισάγουμε το κείμενο από ένα εξωτερικό αρχείο από ένα
τοπικό υπολογιστή, επιλέγουμε ή δημιουργούμε ένα

ιούμε την ιδιότητα fileName στο όνομα του εξωτερικού αρχείου 
υ περιέχει το κείμενο.   

• για να εισάγουμε το κείμενο από ένα αρχείο σε 
etPref (). Εάν καμία μέθοδος setPref δεν έχει ήδη γραφτεί σαν 
μέθοδος getPref () επιστρέφει VOID.  

 
Επεξεργασία κειμ

με τον επιθεωρητή Text, ή 
ειτουργήσει σε ένα παραδοσιακλ

 Πολλοί από τους ίδιους ελέγχους είναι στο διάλογο Font και Paragraph, 
καθώς επίσης και στο παράθυρο Text και τον επιθεωρητή Text.  

Επιλέγουμε την καταλληλότερη επιλογή για το ύφος εργασίας μας. 
 

Επιλογή και εισαγωγή κειμένου στο Stage 
 
Για να εισάγουμε κείμενο στο Stage: 

1. κλικ σ’ ένα text cast member στο Stage να διαλέξουμε ως sprite 
Το text sprite εμφανίζεται ως ένα κανονικό  sprite με διπλά σύνορα. 

 
 

2. κλικ δύο φορές να εισάγουμε το κείμενο 
Ένα σημείο εισαγωγής εμφανίζεται στο κείμενο και μπορούμε να 
αρχίσουμε.   
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3. χρησιμοποιούμε τον Text inspector (Window > Text Inspector) 
πίσης μπορούμε να χρησιμοποιήσουμε Modify > Font και Modify > 

ο text cast member. 

Ε
Paragraph. 
 

Όταν κάνουμε μια αλλαγή, το Director ενημερώνει όλα τα sprites που 
επιδεικνύουν στ
 
Για να εισάγουμε κείμενο στο Stage κατά την διάρκεια της ταινίας: 

1. διαλέγουμε ένα text sprite και κλικ Editable στο μενού Property 
inspector του Sprite 

 
2. ξεκινάμε την ταινία  

 
3. στο Stage, διπλό-κλικ να εισάγουμε κείμενο 

 
ια αλλαγές σε μια παράγραφο:Γ  

ε
 να ανοίξει το παράθυρο Text 

xels 

 το 

Line Spaci

1. διπλό-κλικ στο sprite κείμενο στο Score ή στο cast member κ ίμενο 
στο παράθυρο Cast για

 
2. εάν οι χάρακες δεν είναι διαθέσιμοι, διαλέγουμε View > Rulers,Edit > 

Preferences > General και διαλέγουμε Inches, Centimeters, ή Pi
από το μενού Text Units 

 
3. για να θέσουμε το διάστημα γραμμών, αλλάζουμε τη ρύθμιση με

ng control.  
 

4. για να ρυθμίσουμε την στοίχιση σε μια παράγραφο 
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2.20 Text inspector 
 

 
 

Παρέχει πολλούς χρήσιμους ελέγχους σε ένα συμπαγές παράθυρο για τη 
αράθυρο Cast. χρήση  Stage ή με τα ολόκληρα cast members στο π

ια να εμφανίσουμε τον Text inspector:Γ  
• διαλέγουμε Window > Text Ins
Co

pector, ή πατάμε Control+T (Windows) ή 

ipt 

 ή πεδίο cast member, διαλέγουμε την 

α 

κατωτέρω της  σ’ ένα κείμενο cast 

’ ένα κείμενο cast 
member, διαλέγουμε την ιδιότητα topSpacing 
• για να διευκρινίσουμε το διάστημα γραμμών ’ ένα πεδίο cast member, 
διαλέγουμε την ιδιότητα lineHeight 
• για να προσθέσουμε pixels στην πρώτη περίπτωση σε μια έκφραση 
κομματιών σ’ ένα κείμενο cast member, διαλέγουμε την ιδιότητα 
firstIndent 
• για την αριστερή εσοχή (in pixels) μιας έκφρασης στο κείμενο cast 
member, διαλέγουμε την ιδιότητα leftIndent 
• για την δεξιέ εσοχή (in pixels) μιας έκφρασης στο κείμενο cast member, 
διαλέγουμε την ιδιότητα rightIndent 

mmand+T (Macintosh) 
 

Επεξεργασία παραγράφου με Lingo ή JavaScr
 

Με Lingo ή JavaScript, μπορούμε να ελέγξουμε την μορφοποίηση μιας 
παραγράφου, όπως ευθυγράμμιση και χάραξη για μια έκφραση κομματιών: 
ευθυγράμμιση για ένα κείμενο• 

ιδιότητα alignment 
• διάστημα γραμμών για ένα κείμενο cast member, διαλέγουμε την ιδιότητ
fixedLineSpace 
για να προσθέσουμε pixels  παραγράφου• 

member, διαλέγουμε την ιδιότητα bottomSpacing 
• για να προσθέσουμε pixels ανωτέρω της παραγράφου σ

σ
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2.21 Behaviors 

Behaviors (συμπεριφορά) στο Macromedia Director MX2004 είναι στη 
λώσσα Lingo ή σύνταξη JavaScript, που κάνουμε χρήση, για να παρέχει 
ν αλληλεπίδραση και να προσθέσει τα ενδιαφέροντα αποτελέσματα στην 
ινία μας. Σύρουμε ένα Behavior, από την παλέτα Library και μπαίνει ως 
rite ή ένα πλαίσιο για να το συνδέσει.  
Εάν η συμπεριφορά περιλαμβάνει τις παραμέτρους, ένα πλαίσιο 

ιαλόγου εμφανίζεται που μας αφήνει να καθορίσουμε εκείνες τις 
παραμέτρους.  

Μπορούμε να συνδέσουμε την ίδια συμπεριφορά με πολλά sprites ή 
frames, ανάλογα με τις ανάγκες και τις διαφορετικές παραμέτρους χρήσης 
για κάθε μια περίπτωση της συμπεριφοράς.  

Οι περισσότερες συμπεριφορές αποκρίνονται σε απλά γεγονότα, όπως σ’ 
ένα κλικ του ποντικιού σ’ ένα sprite ή την εισαγωγή playhead σε ένα frame. 

Όταν το γεγονός εμφανίζεται, η συμπεριφορά εκτελεί μια δράση, όπως 
το άλμα σε ένα διαφορετικό frame ή να παίζει ένας ήχος. Για να 
τροποποιήσουμε τις συμπεριφορές, χρησιμοποιούμε τον (επιθεωρητή) 
Inspector Behavior. 

 
Χρησιμοποιώντας το παράθυρο Script 

 
Το παράθυρο Script του Director μας επιτρέπει να προσθέτουμε 

εφαρμογές, κώδικα ενεργοποιημένο από βάση για ταινίες.  
Μπορούμε να γράψουμε σε κώδικα είτε Lingo είτε JavaScript.  
Lingo είναι η «παραδοσιακή γλώσσα» προγραμματισμού του Director, 

ενώ η JavaScript  ήταν συνήθως για να υποστηρίζει πολυμεσικές εφαρμογές 
που προτιμούν να δουλέψουν με JavaScript. 
 

 

γ
τη
τα
sp

δ
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ΚΚΚεεεφφφάάάλλλαααιιιοοο   333

ΠΠΠΑΑΑΡΡΡΑΑΑΡΡΡΤΤΤΗΗΗΜΜΜΑΑΑ   
 
 

Η ΠΛΗΡΟΦΟΡΙΚΗ ΣΤΗΝ ΕΙΔΙΚΗ ΑΓΩΓΗ 
  

ΕΙΣΑΓΩΓΗ  
 

Υπάρχουν πάνω από 750 εκατομμύρια άτομα στον κόσμο που ανήκουν 
στην κατηγορία των ατόμων με ειδικές ανάγκες (ή αναπηρία). Στην Ελλάδα 
να στα δέκα παιδιά είναι άτομο με ειδικές ανάγκες. Από τα κύρια εμπόδια 
που  

οτροπίες και συμπεριφορές που 

ορετικότητα και η ίση μεταχείριση πρέπει να 
ιαμορφώνουν την πραγματικότητα που αντανακλάται στην καθημερινή 
ζωή όλων τω ειχθούν όλα 
α ζητήματα που σχετίζονται με τις ειδικές ανάγκες. Πρέπει να γίνει 
συν

, 

γανωμένης, δημοκρατικής και πολιτισμένης κοινωνίας η 

ία πολύπλευρη στρατηγική που να επικεντρώνεται στο 

 όλα τα επίπεδα.  

ΤΟΡΙΚΗ ΑΝΑΔΡΟΜΗ  

ανάγκες κάτω από την άποψη των 

 το 1975 
ένα ψήφισμα το οποίο περιέχει δήλωση που αφορά τα 

 των οδηγιών για τα άτομα με 
το 

 με ειδικές ανάγκες και επακόλουθο 

   
 

έ
 αντιμετωπίζουν τα άτομα με ειδικές ανάγκες είναι η αρνητική στάση

και η προκατάληψη της κοινωνίας.  
Πρέπει να αλλάξουν στερεότυπα, νο
οδηγούν στον αποκλεισμό.  

Ο σεβασμός στη διαφ
δ

ν πολιτών. Είναι σημαντική ευκαιρία για να αποδ
τ

είδηση σε όλους ότι οι πολιτικές και τα προγράμματα για αυτά τα άτομα 
αποτελούν διάσταση της κοινωνικής ανάπτυξης την οποία καλούνται όλοι
πολίτες και πολιτεία, να στηρίξουν και να ενισχύσουν. Αποτελούν πολύτιμη 
δύναμη της κάθε ορ
οποία οφείλει να προσφέρει στους πολίτες της, την ισότητα ευκαιριών.  

Απαιτείται μ
δικαίωμα των ατόμων με εδικές ανάγκες να συμμετέχουν πλήρως και ισάξια 
στην ενεργό κοινωνία, σε όλες τις μορφές της και σε

 
ΔΙΚΑΙΩΜΑΤΑ ΚΑΙ ΙΣΕΣ ΕΥΚΑΙΡΙΕΣ. ΙΣ

Στις τελευταίες δεκαετίες η προσέγγιση στρέφεται περισσότερο στο 
ζήτημα των ατόμων με ειδικές 
δικαιωμάτων. Οι πρώτες παρεμβάσεις προωθήθηκαν από τα Ηνωμένα 
Έθνη (ΗΕ) κατά την διάρκεια της δεκαετίας του ΄80. Ήδη
εγκρίθηκε 
δικαιώματα των ατόμων με ειδικές ανάγκες. Το γεγονός που οδήγησε 
αργότερα στην ανάπτυξη των πολιτικών και
ειδικές ανάγκες ήταν ο προσδιορισμός τους από την γενική συνέλευση 
1981 ως διεθνές έτος των ατόμων
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άνοιγμα της δεκαετίας του 1983-1992 ως δεκαετία των ατόμων με ειδικές 
νάγκες.  

ς πολίτες. Η δεκαετία των ατόμων 
με 

έ
εξίσωση των ευκαιριών για τα άτομα με ειδικές ανάγκες.  

ατόμου με ειδικές ανάγκες και 
είν

μ

νισμοί  
 

Το σύνολο των άσεις και στην 
ροσφορά των υπηρεσιών που απαιτείται για να εξασφαλίσει ότι τα άτομα 
με 

 την δυνατότητα 
του  για την 
συ

 διευκόλυνση των ατόμων με 
ιδικές ανάγκες για να βελτιώσει τις φυσικές, αισθητηριακές διανοητικές και 
κοινωνικές δυνατότητες τους.  

Επίσης στην ανάγκη να παρασχεθούν τα εργαλεία και τη βοήθεια που 
απαιτείται για να επιτύχει και να διατηρήσει τα δίκαια πρότυπα ζωής. Στους 
τομείς επέμβασης εξετάζονται τα δικαιώματα των ατόμων με ειδικές 
ανάγκες στις διάφορες πτυχές της κοινωνικής ζωής: φυσική δυνατότητα 
πρόσβασης στις θέσεις και πρόσβαση στις πληροφορίες, δικαίωμα στη 
μελέτη, δικαίωμα στην εργασία και γενικά σε όλες τις δραστηριότητες. 
Πρόσβαση στην ενημέρωση και την επικοινωνία: πληροφορίες για τα 
προγράμματα, θεραπεία, ενισχυτικές πολιτικές. Αυτό υπονοεί την 
εκμετάλλευση των ΤΠΕ. Το δικαίωμα να μελετήσει πρέπει να χορηγηθεί 
με την εισαγωγή των ατόμων με ειδικές ανάγκες στις κανονικές 

α
Το σημαντικότερο σημείο του διεθνούς έτους των ατόμων με ειδικές 

ανάγκες ήταν το παγκόσμιο πρόγραμμα των επεμβάσεων για τα άτομα αυτά 
το 1982, το οποίο καθορίζει τις σημαντικές αρχές στον τομέα της πρόληψης 
και της αποκατάστασης, και δίνει έμφαση στο δικαίωμα των ατόμων αυτών 
να έχουν τις ίδιες ευκαιρίες με τους άλλου

ειδικές ανάγκες έδωσε μια ακόμα μεγαλύτερη ώθηση, καθώς η γενική 
συνέλευση των ΗΕ εν κρινε ένα ψήφισμα για τυποποιημένους κανόνες 
σχετικά με την 

Στις 20 Δεκεμβρίου 1993 τα ΗΕ θέσπισαν ένα σύνολο τυποποιημένων 
κανόνων που προβλέπουν ίσες ευκαιρίες στα άτομα με ειδικές ανάγκες. 
Καλύπτουν όλες τις πτυχές της ζωής ενός 

αι δομημένο σε 22 κανόνες που ομαδοποιούνται κάτω από 4 
προσεγγίσεις.  

 • Βασικοί όροι για μια πλήρη συμμετοχή  
 • Τομείς που εξετάζονται για ια πλήρη συμμετοχή  
 • Ενέργειες που λαμβάνονται  
 • Μηχα

κανόνων είναι βασισμένο στις επεμβ
π

ειδικές ανάγκες μπορούν να έχουν πρόσβαση σε θεμελιώδη δικαιώματα.  
Να βελτιωθεί η πληροφόρηση των ατόμων ως προς
ς , οι τοπικές πρωτοβουλίες και ενισχυτικές εγκαταστάσεις
μμετοχής τους στην κοινωνική ζωή. Καθιερώνει την ανάγκη να 

παρασχεθεί όλη η απαραίτητη ιατρική φροντίδα για την αποκατάσταση 
δηλαδή την διαδικασία που στοχεύει στην
ε
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σχολικές βαθμίδες, όσο είναι εφαρμόσιμο. Οι ειδικές σειρές μαθημάτων 
ρέπει να καθιερωθούν όπότε το σχολικό σύστημα δεν μπορεί να αφήσει 

άγκες να τοποθετηθεί σε ένα κανονικό σχολείο.  
 (εποχή που μπαίνει το internet στην ζωή μας) η 

πιτροπή εξέδωσε μια ανακοίνωση σχετικά με την ισότητα της ευκαιρίας 
ια τους α
Η Δια ) 

οπιαστό αποτέλεσμα υ Ευρωπαϊκού Συνεδρίου για την 
υ προσδιορίζει το εννοιολογικό πλαίσιο δράσης για το 2003 

σε 

μ

π
ένα μαθητή με ειδικές αν

Το Ιούλιο του 1996
Ε
γ νθρώπους με ειδικές ανάγκες ως «νέα στρατηγική»  

κήρυξη της Μαδρίτης 
 
(τις 23 Μαρτίου 2002 στην Μαδρίτη

είναι ένα χειρ
Αναπηρία , πο

το

ευρωπαϊκό, εθνικό, περιφερειακό και τοπικό επίπεδο και υποδεικνύει 
συγκεκριμένες προτάσεις προς όλους τους εμπλεκόμενους φορείς, που θα 
επιφέρουν ισότητα για όλες τις κατηγορίες ατόμων με αναπηρία και τις 
οικογένειες τους.  

Στην Ελλάδα τόσο ο νόμος 2817/2000 για την ειδική αγωγή όσο και για 
κ τόλα τα ρά η της Ευρωπαϊκής Ένωσης, Άτομο ε ειδικές ανάγκες είναι 

εκείνο που ξεχωρίζει, που διαφέρει αισθητά από τους άλλους, που αποκλίνει 
από . το κανονικό  Η απόκλιση αυτή μπορεί να είναι προς τα άνω ή προς τα 
κάτω. Γενικά άτομα με Ειδικές Ανάγκες είναι όλα τα άτομα με 
μειονεκτήματα στο σύνολο της προσωπικότητας τους.  

Οι κυριότερες κατηγορίες αφορούν άτομα με προβλήματα:  
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ΤΟ ΕΚΠΑΙΔΕΥΤΙΚΟ ΣΥΣΤΗΜΑ ΕΙΝΑΙ ΤΟ ΠΡΩΤΟ ΒΗΜΑ ΠΡΟΣ 
ΤΗΝ ΑΝΟΙΧΤΗ ΚΟΙΝΩΝΙΑ 

ς 
μα

η
 αρχές της πλήρους συμμετοχής και ισότητας.  

Η του μέλλοντος του 
καθενός κή και 
επ

 σύστημα μπορεί να συμβάλει στην προσωπική 
νάπτυξη και την κοινωνική ένταξη, που θα επιτρέψει στα παιδιά και τους 
νέο

ΣΤ

έ ί

ύ συστήματος.  

α δ ν σ

 
Σύμφωνα με την Εθνική Συνομοσπονδία Ατόμων με Ειδικές Ανάγκες 

(ΕΣΑΕΑ, κ. Γ. Βαρδακαστάνη, 2003 ), η εκπαίδευση μπορεί και πρέπει να 
παίξει πρωταγωνιστικό ρόλο στην διάδοση του μηνύματος της κατανόησης 
και της αποδοχής των δικαιωμάτων των ατόμων με αναπηρία, 
συμβάλλοντας στην απομάκρυνση των φόβων, των μύθων και των 
εσφαλμένων αντιλήψεων και υποστηρίζοντας την προσπάθεια ολόκληρης 
της κοινότητας. Η εκπαιδευτική εφευρετικότητα μπορεί να βοηθήσει του
θητές να αναπτύξουν μια αίσθηση ατομικότητας σε σχέση με την 

αναπηρία, τη δική τους ή και των άλλων να προσεγγίσουν τη διαφορά με 
θετικό τρόπο.  

Είναι απαραίτητο να επιτύχουμε μία εκπαίδευσ  για όλους, 
βασισμένη στις

εκπαίδευση παίζει βασικό ρόλο στο καθορισμό 
, τόσο σε προσωπική βάση όσο και σε κοινωνι

αγγελματική.  
Συνεπώς, το εκπαιδευτικό

α
υς με αναπηρία να γίνουν όσο το δυνατόν πιο ανεξάρτητοι.  

 
ΟΙ ΤΕΧΝΟΛΟΓΙΕΣ ΠΛΗΡΟΦΟΡΙΑΣ ΚΑΙ ΕΠΙΚΟΙΝΩΝΙΑΣ (ΤΠΕ) 

Ο ΕΚΠΑΙΔΕΥΤΙΚΟ ΣΥΣΤΗΜΑ ΩΣ ΕΡΓΑΛΕΙΟ ΓΝΩΣΗΣ 
 

Οι ΤΠΕ χουν επιφέρει σημαντικές αλλαγές στην εργασ α και στην 
καθημερινή ζωή μας. Αποτελούν πλέον ένα αναπόσπαστο εργαλείο της 
σύγχρονης εκπαίδευσης. Λειτουργούν καταλυτικά, επηρεάζουν τη δομή του 
σχολείου και κατά ουσία συμβάλλουν στην τροποποίηση και στην 
αναμόρφωση του εκπαιδευτικο

Οι ΤΠΕ έχουν εισέλθει στο Ελληνικό Σχολείο από το 1984. Ξεκίνησαν 
με την εισαγωγή του μαθήματος Πληροφορικής ως γνωστικό αντικείμενο σε 
ορισμένες τάξεις του γυμνασίου και του λυκείου. Όμως οι αυξανόμενες 
ανάγκες της επαγγελματικής κατάρτισης και η εξέλιξη οδήγησαν σε 
γενικευμένη εισαγωγή. Προγραμματίστηκαν και υλοποιήθηκαν σειρά έργων 
για την επέκταση των ΤΠΕ ως εργαλείο διδασκαλίας και μάθησης για όλα 
τα γνωστικά αντικείμενα. Με συνεργασία των εκπαιδευτικών φορέων και 
υπό την αιγίδ  του Υπουργείου Παι είας η χρήση τω  ΤΠΕ την 
εκπαίδευση, τόσο στην γενική όσο και στην ειδική, αποτελεί 
αναμφισβήτητη πραγματικότητα.  
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Φυσικά δεν εννοείται ότι η είσοδος και η χρήση των ΤΠΕ στην ειδική 
αγωγή θα έχει την μορφή εκπαιδευτικού εργαλείου. Εννοείται φυσικά ότι 
απαιτεί μια νέα μορφή ανάπτυξης της εκπαιδευτικής τεχνολογίας.  

Η καθαυτή λειτουργία των ΤΠΕ
 
στην εκπαίδευση και ειδικότερα στην 

Ειδική Αγωγή συνίσταται στην εκμετάλλευση των θετικών στοιχείων που 
παρέχουν ανάλογα με το διδακτικό αντικείμενο και τους στόχους σε 
συ

υ με αυτό. Με τον τρόπο αυτό σπάζουν οι φραγμοί που 
εκπ

 ε
 ένα μέσο-εργαλείο, 

αναγν ιών, την 
ανάγκη για υποστηρικτικά συστήματα, ώστε το σύστημα αυτό να παρέχει 
βοήθεια σε όλα τα παιδιά. Γενικά υπάρχουν δυσκολίες. Δυσκολίες 
νοοτροπίας των γονέων, της κοινωνίας ευρύτερα, έλλειψη πόρων, ανάγκες 
επαγγελματικής κατάρτισης και επιμόρφωσης, ανάγκες προγραμματισμού 
και αξιολόγησης.  

Είναι γεγονός ότι χρειάζεται μια ενιαία εκπαίδευση  όλους, με έμφαση 
την αρχή: το σύστημα πρέπει να ικανοποιεί τις  όλων των 
αιδιών και δεν θα πρέπει να ταιριάξουμε το παιδί στο σύστημα, ούτε 
ρέπει να αλλάξουμε ένα τμήμα του συστήματος για να εξυπηρετηθεί ένα 
τομο ή μια ομάδα ατόμων. Και αφορά το σύνολο του εκπαιδευτικού 
υστήματος. Δεν είναι μόνο για τα σχολεία ή για μια περιοχή της 
κπαίδευσης.  
Επίσης πρέπει να εξετάζονται τα θεμελιώδη δικαιώματα όλων των παιδιών, 
ίσες ευκαιρίες και συμμετοχή σε ένα ενιαίο σύστημα εκπαίδευσης.  

Ο βασικός εκπαιδευτικός στόχος είναι όλα τα παιδιά να επιτύχουν 
αυτονομία, ικανότητα για επικοινωνία, πρόσβαση στην πληροφορία, 
κοινωνικοποίηση και αντίστοιχη ακαδημαϊκή πρόοδο. Μία πρόοδο που 
συμβαδίζει με την σχολική εξέλιξη.  

Η αξιοποίηση των ΤΠΕ στην εκπαίδευση δεν πρέπει να διαχωρίζει την 
ειδική από την γενική εκπαίδευση. Πρέπει να υπάρχει ένας υποστηρικτικός 

νάρτηση με τις ειδικές εκπαιδευτικές ανάγκες κάθε κατηγορίας 
μαθητών.  

Η τεχνολογία μπορεί να υποκαταστήσει σε μεγάλο βαθμό στοιχεία της 
μειονεξίας ή της αναπηρίας φέρνοντας το μαθητή πιο κοντά στο γνωστικό 
αγαθό αλλά και στην κοινωνική πραγματικότητα αφού του δίνει τη 
δυνατότητα της επικοινωνίας με το περιβάλλον του και την 
αλληλεπίδραση το

ορεύονται από την φύση της μειονεξίας ή της αναπηρίας και 
φέρνουν το άτομο πιο κοντά στην σχολική ένταξη και την κοινωνική 
ενσωμάτωση.  
 

Για την πρωτοβάθμια εκπαίδευση, οι αλλαγές και οι ξελίξεις, όσον 
αφορά το νέο σύστημα με την χρήση των ΤΠΕ σαν

ωρίζουν το ρόλο των γονέων, την ατομικότητα των παιδ

για
ανάγκεςσ

π
π
ά
σ
ε
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μηχανισμός, νόμος πλαίσιο, που να προστατεύει, να ελέγχει και να 
αξιολογεί το σύστημα. Ώστε το σύστημα να εξελίσσεται. Με κύριο όφελος 
το παιδί. Το παιδί πρέπει να έχει ίσες ευκαιρίες και δικαιώματα πρόσβασης 
στη

 ανάγκε
σ

ής πρέπει να προσαρμόζεται στο σύστημα και όχι να 
βγά  

ι θέματα 
ευα

ς σ τ ι σ
 μπορεί να ενσωματώσει τα άτομα με ειδικές ανάγκες 

ακ

καλείται να 
υμμετάσχει και να συντονίσει μια δραστηριότητα με την χρήση των ΤΠΕ.  

σης. Ο 
πολογιστής μετατρέπεται σε εργαλείο γνώσης και εργασίας. Ο ρόλος του 
μα

έει πολύ καθαρά ότι «κάθε 
σχ

 χ

ν εκπαίδευση σε όλα τα σχολεία.   
 
Στην δευτεροβάθμια εκπαίδευση είναι μεγαλύτερη η πρόκληση της 

αξιοποίησης των ΤΠΕ για άτομα με ειδικές ς. Αυτό οφείλεται κυρίως 
στις αυξανόμενες απαιτήσεις του σχολικού προγράμματος, αλλά και τον 
τρόπο σύνδεσης–σχέσης της εμπειρίας του καθηγητή για την μεταφορά 
γνώσεων στο ενιαίο σχολείο δευτεροβάθμιας εκπαίδευσης. Ο παράγων 
κλειδί βρίσκεται στην αφοσίωση και στην συνεργασία των καθηγητών με 
τους μαθητές.  

Ο καθηγητ
ζει το παιδί από το σύστημα. Η αξιοποίηση των ΤΠΕ βοηθά τον 

καθηγητή να ενσωματώσει τους μαθητές και παραβλέπε
ισθησίας και νοοτροπίας του. Οι ΤΠΕ είναι βασικός πόρος, όπου ο 

καθηγητή  με ωσ ή κατάρτιση κα  συνεχή επιμόρφωση την 
αξιοποίηση τους
ολουθώντας σωστή μεθοδολογία και τρόπο.  
Η μελέτη των Μ.Collins και Z. Berge περιγράφει το πώς εμπλουτίζεται 

και αλλάζει ο ρόλος του δασκάλου / καθηγητή, όταν 
σ

Η αλλαγή του ρόλου του δασκάλου / καθηγητή αφορά κυρίως στο 
περιεχόμενο γνωστικών αντικειμένων και στους τρόπους μάθη
υ
θητή με ειδικές ανάγκες αλλάζει. Από παθητικός δέκτης γνώσεων γίνεται 

δημιουργός της δικής του γνώσης. Γίνεται μέλος ομάδας σε συλλογικές 
εργασίες, επικοινωνεί με τους συμμαθητές του, έχει πρόσβαση σε πηγές και 
υλικό.  

Πρέπει να διαβάσουμε μια φράση που λ
ολείο πρέπει να είναι μια κοινότητα, η οποία αναλαμβάνει από κοινού 

την ευθύνη της επιτυχίας ή της αποτυχίας του κάθε μαθητή»  
Βέβαια μια επιτυχημένη ενσωμάτωση δεν αποσκοπεί στο να 

θεωρήσουμε το σχολείο πετυχημένο ή στην συνέχιση μεγάλου αριθμού 
παιδιών στην τριτοβάθμια εκπαίδευση. Κριτήριο επιτυχίας είναι η επιτυχία 
της εκπαίδευσης για όλους τους μαθητές του σχολείου. Οι ΤΠΕ μέσω 
ειδικών προγραμμάτων προωθούν την ανεξαρτησία του μαθητή και δεν 
είναι ο μαθητής πλέον ένας απλός ρήστης αλλά είναι ο παράγων κλειδί 
στην ενσωμάτωση.  
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Στην τριτοβάθμια εκπαίδευση υπάρχει διαφορετική αντιμετώπιση. 
Είναι πολύ δύσκολο γιατί υπάρχει πολλές φορές μια ανταγωνιστική λογική 
στην λειτουργία των πανεπιστημίων, κάτι που στην Ελλάδα δεν είναι τόσο 
έντ

ετοχή τους ως φοιτητές, ερευνητές ή υποψήφιοι διδάκτορες. 
Ειδ

ετάσεις στο μεγαλύτερο μέρος του ακαδημαϊκού έτους.  

Μα

ονο στην πρωτοβάθμια και δευτεροβάθμια εκπαίδευση.  
Βέβαια στην πανεπιστημιακή κοινότητα δεν μας πείθει μονάχα η 

παρουσία των ατόμων με ειδικές ανάγκες στα αμφιθέατρα αλλά η πλήρης 
συμμετοχή τους σε όλες τις μορφές. Εδώ η αξιοποίηση των ΤΠΕ αφορά 
στην συμμ

ικά στο θέμα των διαγωνισμών και των εξετάσεων, η πανεπιστημιακή 
κοινότητα πρέπει να υποστηρίζει τα άτομα με ειδικές ανάγκες.  

Παράδειγμα, όλες οι σημειώσεις πρέπει να είναι και σε ανάγλυφη μορφή 
αφού υπάρχουν άτομα τυφλά. Αυτό προϋποθέτει ένας ειδικός σχεδιασμός 
αλλά και διδακτικές εφαρμογές με προσαρμοσμένη μελέτη υλικών. Μπορεί 
δηλαδή ο φοιτητής με ειδικές ανάγκες να επιλέξει την αξιολόγηση του αν 
είναι προφορική ή γραπτή, αλλά και η πανεπιστημιακή κοινότητα να 
επεκτείνει τις εξ
 

Τα οφέλη που προκύπτουν από την εισαγωγή των ΤΠΕ στην Εκπαίδευση 
μαθητών με ειδικές εκπαιδευτικές ανάγκες, γεγονός που αναδεικνύει την 
αναγκαιότητα της πραγμάτωσής της, εντοπίζονται συνοπτικά στα παρακάτω 
σημεία:  

 
ΕΝΔΕΙΚΤΙΚΕΣ ΑΝΑΦΟΡΕΣ ΑΠΟΤΕΛΕΣΜΑΤΙΚΟΤΗΤΑΣ – 

«ΈΞΥΠΝΕΣ ΣΥΣΚΕΥΕΣ» 
 

θητές με ειδικές μαθησιακές δυσκολίες (π.χ. δυσλεξία)  

 
 

Πρόκειται για την ομάδα εκείνη που παρουσιάζει προβλήματα κατά την 
ανάγνωση και την ορθή γραφή. Συμπτώματα δυσλεξίας αποτελούν: η 
αντιστροφή των γραμμάτων, παραλείψεις, η καθρεφτική γραφή, 
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αντιμεταθέσεις. Γενικότερα το κείμενό τους είναι δυσανάγνωστο ενώ 
παρουσιάζουν προβλήματα προσανατολισμού στο χώρο. Τα ερευνητικά 
δεδομένα των τελευταίων χρόνων πιστοποιούν ότι η χρήση των νέων 
τεχνολογιών μπορεί να συμβάλλει αποτελεσματικά στον περιορισμό της 
εκδήλωσης των συμπτωμάτων. Τα οπτικά και ακουστικά ερεθίσματα που 
παρέχει ο υπολογιστής, η καθαρή και τακτική παρουσίαση του κειμένου, 
λογισμικά που στοχεύουν στη διόρθωση των λαθών και που υπενθυμίζουν 
γραμματικούς κανόνες βοηθούν ιδιαίτερα αυτούς τους μαθητές (Singleton 
1991).  

 
Μαθητές με κινητικά προβλήματα και αισθητηριακές δυσλειτουργίες 
 

 
 

Στην ομάδα αυτή ανήκουν μαθητές που παρουσιάζουν σωματικές 
δυσλειτουργίες (αδυναμίες κίνησης) ή δυσλειτουργίες των αισθητηρίων 
οργάνων (προβλήματα όρασης και ακοής). Είναι μεγάλος ο αριθμός των 
μαθητών εκείνων που δεν μπορούν να κάνουν έστω και απλές κινήσεις: 
όπως να πιάσουν μολύβι, να ξεφυλλίσουν ένα βιβλίο, να γράψουν.  

Ορισμένοι μάλιστα αδυνατούν να προσηλώσουν το βλέμμα τους, να 
κρατήσουν σταθερό το κεφάλι τους. Απέναντι σε αυτές τις καταστάσεις οι 
νέες τεχνολογίες προτείνουν: ειδικές συσκευές που προσαρτώνται στο 
κεφάλι ή το πόδι και με τη βοήθεια εξαρτήματος γίνεται χρήση του 
πληκτρολογίου. Επιπλέον, παρέχεται η δυνατότητα ο χρήστης κοιτάζοντας 
την οθόνη, στην οποία εμφανίζονται διαδοχικά τα στοιχεία και με τους 
ανάλογους αργούς ρυθμούς, να δίνει την κατάλληλη εντολή με ένα απλό 
δια κ τκόπτη ή ινών ας κάποιο ειδικό καλώδιο.  

Πολλά είναι τα παραδείγματα εκείνα, παράλυτων ατόμων όπου με τη 
φωνή ή το ανοιγόκλεισμα των βλεφάρων τους επιτυγχάνουν να 
χρησιμοποιούν τον υπολογιστή και να έχουν αποτελέσματα παρόμοια με 
εκείνα των ατόμων χωρίς κινητικά προβλήματα.  

Αλλά και για τους μαθητές εκείνους που παρουσιάζουν ελαφρές μορφές 
κινητικής δυσλειτουργίας έχουν αναπτυχθεί συσκευές, όπως πληκτρολόγια, 
που δεν επηρεάζονται από αδέξιους χειρισμούς του χρήστη (όπως 
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τρε α

ς με αυτό τον 
τρό

μούλι σμα των χεριών, ασταθής κίνηση των χεριών, παρατεταμένο 
πάτημα των πλήκτρων ή πάτημα πολλών πλήκτρων ταυτόχρονα). Επίσης 
υπάρχει αντίστοιχο υλικό αλλά και λογισμικό, το οποίο πραγματοποιεί 
πολλές αυτοματοποιημένες λειτουργίες ελαχιστοποιώντα

πο την πολυπλοκότητα των απαιτούμενων κινήσεων.  
 

                        
 

Μαθητές που εξαιτίας μυϊκών αδυναμιών κουράζονται εύκολα μπορούν 
να χρησιμοποιούν στο σχολικό χώρο φορητούς υπολογιστές και να 
ανταποκρίνονται επιτυχώς στις απαιτήσεις του Σχολείου.  

Άτομα που αδυνατούν να ομιλήσουν μπορούν να επικοινωνήσουν μέσω 
ου υπολογιστή, πληκτρολογώντας τα σήματα που επιθυμούν. Επίσης 
προ

έσω της κάρτας ήχου και των ηχείων του υπολογιστή μας. Η 
ταυτόχρονη υποστήριξη οθονών Braille δίνει στα άτομα με προβλήματα 
όρα  
πληροφορία Προγράμμ ύν κάθε κείμενο που 
μφανίζεται στην οθόνη (έγγραφα, μενού, ιστοσελίδες, emails, κ.α.) ακόμη 

στοιχεία.  
Μαθητές που παρουσιάζουν προβλήματα όρασης (τυφλοί μαθητές) έχουν 

τη δυνατότητα να εργάζονται με πληκτρολόγια αφής και χρησιμοποιώντας 
κατάλληλο λογισμικό, που αξιοποιεί τα υπέρ-κείμενα μέσα, να έχουν 
πρόσβαση στη βιβλιογραφία.  
 
Μαθητές με αδυναμίες στο νοητικό τομέα ή νοητική υστέρηση 
 

Πρόκειται για τους μαθητές εκείνους που μαθαίνουν με πολύ αργούς 
ρυθμούς σε σχέση με τους υπολοίπους ή για εκείνους που παρουσιάζουν 

 υστέρηση (Δείκτη νοημοσύνης< 70). Στους μαθητές αυτούς μέσω 
ατ

τ
γράμματα ανάγνωσης οθόνης σαν ένα βασικό εργαλείο για κάθε τυφλό 

χρήστη ηλεκτρονικού υπολογιστή, αφού με την βοήθεια του προγράμματος 
σύνθεσης φωνής που περιέχει επιτυγχάνει την ανάγνωση των δεδομένων της 
οθόνης μ

σης που τις χρησιμοποιούν μια ακόμα δυνατότητα πρόσβασης στη
ατα που μπορούν να εκφωνο

ε
και να εκφωνούν και τα εικονίδια και τα περισσότερα γραφικά 

νοητική
κ άλληλων παιχνιδιών προσομοίωσης και με τη χρήση ανάλογων 
πληκτρολογίων που αντιστοιχούν σε εικόνες ή έννοιες, εμπλέκονται οι 
μαθητές αυτοί σε καταστάσεις της καθημερινότητας (όπως συναλλαγή με 
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χρήματα, συγκρίσεις και υπολογισμοί μεγεθών) κατανοώντας με αυτό τον 
τρόπο μαθηματικές έννοιες.  

 
Επιπλέον η χρήση προγραμμάτων τους επιτρέπει να εξερευνούν 

μαθηματικές σχέσεις, να προσεγγίζουν τη Γεωμετρία, και να ανακαλύπτουν 
ς 

ρηματικής συναλλαγής οι μαθητές με νοητικές αδυναμίες ή νοητική 
υστέρηση καταφέρνουν να μάθουν βασικές αριθμητικές πράξεις (πρόσθεση, 
αφαίρεση, πολλαπλασιασμό) ή να επιλύουν στοιχειώδη αριθμητικά 
προβλήματα. Επίσης με τη χρήση και την ανάπτυξη λογισμικού βάσης 
δεδομένων μπορούν οι μαθητές που μαθαίνουν με πολύ αργούς ρυθμούς να 
κατακτήσουν μαθηματικές έννοιες και να αποκτήσουν δεξιότητες επίλυσης 
προβληματικών καταστάσεων. 

ποσοτικά φαινόμενα. Με τη βοήθεια των προγραμμάτων προσομοίωση
χ

         
 

Προσβασιμότητα στο WEB για άτομα με ειδικές ανάγκες και στα 
σχολικά intranets με assistive τεχνολογίες  
 

Η W3C δημιουργήθηκε για να οδηγήσει το WEB στην πλήρη 
δυνατότητά του με την ανάπτυξη των κοινών πρωτοκόλλων που προωθούν 
την εξέλιξή του και της κοινοπραξίας.

Είναι μια διεθνής κοινοπραξία βιομηχανίας που οργανώνεται από κοινού 
απ το 

χο (INRIA) 

ραξία περιλαμβάνουν: μια 
απ

ό το εργαστήριο MIT για την πληροφορική (MIT LCS) στις ΗΠΑ, 
εθνικό ίδρυμα για την έρευνα στην πληροφορική και τον έλεγ
στο πανεπιστήμιο Γαλλία και Keio στην Ιαπωνία.  

Οι υπηρεσίες που παρέχονται από τη κοινοπ
οθήκη των πληροφοριών για το World Wide Web για τους υπεύθυνους 

για την ανάπτυξη και τους χρήστες και διάφορες εφαρμογές πρωτοτύπων 
και δειγμάτων για να καταδειχθεί η χρήση της νέας τεχνολογίας. Το UAAG 

 59



1,0 γράφεται για τους υπεύθυνους για την ανάπτυξη λογισμικού, και 
εξετάζει τις απαιτήσεις όπως η δυνατότητα πρόσβασης του ενδιάμεσου με 
τον χρήστη, απόδοση των πληροφοριών δυνατότητας πρόσβασης, και την 
επιλογή χρηστών στη διαμόρφωση των browsers και των media players. 
Αυτές οι οδηγίες εξετάζουν επίσης τη δια-λειτουργικότητα

 
 των mainstream 

rowsers και των multimedia players με τις assistive τεχνολογίες που 
χρησιμοποιούνται από ανθρώπους με ειδικές ανάγκες. Οι οδηγίες UAAG 
1.0 είναι τρίτες σε ένα συμπληρωματικό σύνολο οδηγιών δυνατότητας 
πρόσβασης Ιστού που περιλαμβάνουν ήδη τις οδηγίες δυνατότητας 
πρόσβασης περιεχομένου Ιστού Web Content Accessibility Guidelines 
(WCAG 1.0) και οι οδηγίες τας πρόσβασης εργαλείων 
ημιουργίας Authoring Tool Accessibility Guidelines (ATAG 1.0). Με τις 
οδη

ΚΑ

τις 
εξε

οβλήματα ακοής.  
Από την υλοποίηση του έργου θα ωφεληθεί πρώτα από όλα το σύνολο 

 Αγωγής 
) και σχολεία γενικής εκπαίδευσης, οι εκπαιδευτικοί, και οι γονείς 

αλ

π ί

 

b

1,0 δυνατότη
δ

γίες αυτές θα μετασχηματισθούν όλοι οι σχολικοί τόποι ώστε να έχουν 
προσβασιμότητα.  
 

ΤΑΣΤΑΣΗ ΣΤΗΝ ΕΛΛΑΔΑ  
 

Βάση
 
του Επιχειρησιακού Σχεδίου του Υπουργείου Παιδείας και το 

ΜΕΤΡΟ 1.1 που αφορά τον «Εξοπλισμός και δικτύωση σε όλες τις βαθμίδες 
της Εκπαίδευσης» θα προχωρήσει η Προμήθεια και Εγκατάσταση 
Υπολογιστικού και Ειδικού Εξοπλισμού στις Μονάδες Ειδικής Αγωγής.  

Το αντικείμενο του έργου είναι η προμήθεια και εγκατάσταση 
υπολογιστικού, δικτυακού και ειδικού εξοπλισμού για την κάλυψη των 
αναγκών των μονάδων ειδικής αγωγής στην Ελλάδα. Στόχος είναι η 
δημιουργία εργαστηρίων υποστηρικτικού εξοπλισμού στις μονάδες ειδικής 
αγωγής που να εξυπηρετούν την διδασκαλία και τη μάθηση σ

ιδικευμένες κατηγορίες ειδικών ατόμων. Οι κατηγορίες τέτοιων μαθητών 
που θα εξυπηρετηθούν από το έργο είναι: (α) άτομα με προβλήματα όρασης, 
(β) άτομα με κινητικά προβλήματα, (γ) άτομα με προβλήματα νοητικής 
υστέρησης και (δ) άτομα με πρ

των μαθητών, οι οποίοι φοιτούν σε Σχολικές μονάδες ειδικής
(ΣΜΕΑ
λά και οι διοικητικοί και επιστημονικοί Φορείς του ΥΠΕΠΘ (Διεύθυνση 

Ειδικής Αγωγής, Παιδαγωγικό Ινστιτούτο).  
Ο σχεδιασμός του εξοπλισμού των Κέντρων Διάγνωσης Αξιολόγησης 

και Υποστήριξης (ΚΔΑΥ) και των ΣΜΕΑ ου ακολουθε , στοχεύει στην 
αποτελεσματική υλοποίηση του νόμου 2817/2000. 
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